REN ESAS Application Note

RZ/A3UL
Getting Started with RZ/A Flexible Software Package

Introduction

This manual describes how to use the RZ/A Flexible Software Package (FSP) for developing applications for
the RZ microprocessor series.

Target Device
RZ/A3UL
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1. Introduction

1.1 Overview

This application note describes how to use the Renesas RZ/A Flexible Software Package (FSP) running on
the Cortex®-A55 (hereinafter referred to as CA55) incorporated on RZ/A3UL.

1.2 Introduction to FSP

1.2.1 Purpose

The Renesas RZ/A Flexible Software Package (FSP) is an optimized software package designed to provide
easy to use, scalable, high-quality software for embedded system design. The primary goal is to provide
lightweight, efficient drivers that meet common use cases in embedded systems.

1.2.2 e2 studio IDE

FSP provides a host of efficiency enhancing tools for developing projects targeting the Renesas RZ series of
MPU devices. The e2 studio IDE provides a familiar development cockpit from which the key steps of project
creation, module selection and configuration, code development, code generation, and debugging are all
managed.

1.3 Limitations

1.3.1 Hardware Initial Setup

RZ/A FSP expects the initial setup of hardware should be carried out beforehand by RZ/A Initial Program
Loader (hereinafter referred to as IPL). For detail on IPL, please refer to the Application Note.
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2. Starting Development Introduction

2.1 e2 studio setup

2.1.1 What is e2 studio?

Renesas e2 studio is a development tool encompassing code development, build, and debug. e2 studio is
based on the open-source Eclipse IDE and the associated C/C++ Development Tooling (CDT).

When developing for RZ MPUs, e2 studio hosts the RZ/A FSP. The FSP provides a wide range of time
saving tools to simplify the selection, configuration, and management of modules and threads, to easily
implement complex applications.

2.1.2 e2 studio Prerequisites
2.1.2.1 Obtaining an RZ MPU Kit

To develop applications with RZ/A FSP, start with RZ/A3UL Evaluation Board Kit.
RZ/A3UL Evaluation Board Kit related information is available at RZ/A3UL Evaluation Board Kit.

The relationship between the board type and the board name on e?studio is as follows.

Board name on GUI screen | Note

QSPI Edition RZ/A3UL Evaluation Board If you select this, the initial program loader
(RTK9763U02S01000BE) | Kit QSPI Edition (Exec with will transfer the entire program including the
DDR SDRAM) code area to DDRA4.

RZ/A3UL Evaluation Board If you select this, only the data area will be
Kit QSPI Edition (eXecute-In- | transferred to DDR4 by the initial program

Place) loader. The code area on the flash ROM is
referenced during execution.
Octal-SPI Edition RZ/A3UL Development board | If you select this, only the data area will be
(RTK9763U02S01001BE) | Dialog OCTAL Boot transferred to OctaRAM by the initial
(eXecute-In-Place) program loader. The code area on the flash

ROM is referenced during execution.

2.1.2.2 PC Requirements
The following are the minimum PC requirements to use e2 studio:

e Windows 10 or Ubuntu 20.04 LTS Desktop(64-bit) with Intel i5 or i7, or AMD A10-7850K or FX
e Memory: 8-GB DDR3 or DDR4 DRAM (16-GB DDR4/2400-MHz RAM is preferred)
e Minimum 250-GB hard disk

2.1.2.3 Licensing

FSP licensing includes full source code, limited to Renesas hardware only.

2.1.3 e2 studio installation for Windows PC

This chapter describes how to install the e2 studio IDE on Windows PC. If you would like to install e2 studio
and FSP at the same time, please jump to 2.2.1.

21.3.1 Download

The latest e2 studio IDE installer package can be downloaded from Renesas website for free. Please check
detailed information from: https://www.renesas.com/e2studio. Note that user has to login to the Renesas
account (in MyRenesas page) for the software download.
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2.1.3.2 Installation of e2 studio IDE

1. Double-click the e2 studio installer to launch the e2 studio installation wizard. Then, select the [Custom
Install] option and click the [Next] button.

&M Renesas e? studio 2024-04 Setup O X

Renesas e’ studio 2024-04 Setup .z E N ESAS

Install Type

Please select the e studio installation type. Click here for help selecting a type and to see what features are included.

Select Install Type:

—_ Lite Install (Recommended)
(G ) This installs e? studio in Lite Mode.
"~ This mode offers a simplified experience focused on simple code editing & debugging with only important features

__ Standard Install
(&) This installs e? studio in Advanced Mode.
~ This mode offers all extended debugging

functionality and other advanced features

Custom Install

Custom installation of e* studio
This mode is allows you to select which features are installed

< Back Install Cancel

Figure 1: e2 studio installation wizard

Note:
If you are using a multi-user environment, you may receive a prompt to confirm whether you want to
install it for the current user only or for all users.

Renesas Installer

G Select which users to install for

— All Users

Install for all users on this computer
Requires Administrator permissions

—> Current user
Install for N only

Parts may require Administrator permissions

= Cancel installation

Figure 2: Select User for Installation
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2. Welcome page
User can change the install folder by clicking [Change...]. Click [Next] to continue.

Note:
1. If you would like to have multiple versions of e2 studio, please specify new folder here.
2. Multi-byte characters cannot be used for e2 studio installation folder name.

&N Renesas e? studio 2024-04 Setup O X

Renesas e’ studio 2024-04 Setup Il 1 E N ESAS
@ Welcome

Install directory ready

Install Location:
han [Change...

Prerequisite software already installed

Change Proxy Settings...

Ready to install

Software to install:
« Renesas e2 studio v24.4.0.R20240328-1906
« Java Runtime v17.0.0
« |AR Plugin Manager v1.1.0.202007251457
« Renesas e2 studio Common Components (Lite) v24.4.0.R20240328-1906
* Renesas e2 studio Common Components (Full) v24.4.0.R20240328-1906
* Renesas QE Common Components v24.4.0.R20240328-1906
« Eclipse CDT Linker Script Editor and DSL v1.0.111.v20240311-1345
. Justl Adoptlum OpenJDK Hotspot JRE Complete v17 0.10.v20240120-1143 v

° Internet connection available

Figure 3: Installation of e2 studio — Welcome page
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3. Device Families

Select Devices Families to install. Click the [Next] button to continue.

&N Renesas e? studio 2024-04 Setup O X
Renesas e’ studio 2024-04 Setup
o LENESAS
Select the device families you wish to install support for
Welcome 0 A% RA A
E o RA Build, Debug & Code Generation support for Renesas RA devices
Device Families
RZ : - i
Build, Debug & Code Generation support for Renesas RZ devices
N @ﬂ RL78
RU78 Build, Debug & Code Generation support for Renesas RL78 devices
O R RX
X Build, Debug & Code Generation support for Renesas RX devices
. @ﬂ RH850
RHB850 Debug support for Renesas RH850 devices
. @\ RE
ReE Build & Debug support for Renesas RE devices
Syner
[JRENESAS ynersy
Build, Debug & Code Generation support for Renesas Synergy devices
—_&Ydialoa PA v
Select All
< Back \ Install Cancel
Figure 4: Installation of e2 studio — Device Families
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4. Extra Features
Select Extra Features (i.e., Language packs, Git support...) to be installed. For non-English language
users, please select Language packs at this step if needed. Then, click the [Next] button to continue.

&N Renesas e? studio 2024-04 Setup Od X

Renesas e’ studio 2024-04 Setup o 1 E N ESAS

Select the extra features you wish to install

Welcome =S Japanese Language Support
L] =
Device Families
Chinese (Simplified) Language Support
@ Extra Features O | e i
Chinese (Traditional) Language Support
(] =
Git Integration
(] = ,
Git SCM Support
Terminals
[] L A : _
ANSI/vt102 compatible Terminal support for Serial, ssh and Telnet
Select All

ik | vets | e

Figure 5: Installation of e2 studio — Extra Features
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5. Customize Features

Select the components to install and click the [Next] button to continue. Be sure to choose “Renesas FSP
Smart Configurator Core”. Otherwise, FSP won’t be built on e2 studio successfully.

&N Renesas e? studio 2024-04 Setup O X

RENESAS

Renesas e’ studio 2024-04 Setup

Walcome Select the components you want to install.
A
Device Families & () Renesas RE Family Support (24.4.0.R20240328-1906)
Extra Features e = Saat b
@ Customise < (] Renesas Synergy Family Support (24.4.0.R20240328-1906)
Features % () Renesas DA Family Support (24.4.0.R20240328-1906)
Renesas FSP Smart Configurator Core (9.5.0.v20240328-0843)
Renesas FSP Smart Configurator ARM (9.5.0.v20240327-1425)
& (J Renesas RISC-V MCU Support (24.4.0.R20240328-1906)
% () Renesas QE Common Components (24.4.0.R20240328-1906)
[ Git integration for Eclipse (6.8.0.202311291450-r)
&s (1 Additinnal Tnnls (24 4 0 R2N24032R8-190AY b

Select All Optional | Deselect All Optional

Size of install: 912.2 MB

< Back Install Cancel

Figure 6: Installation of e2 studio — Features
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6. Licenses Agreement
Please read and accept the software license agreement, then click the [Next] button. Note that
acceptance of the license agreement is mandatory; without it, the installation process cannot proceed.

&N Renesas e? studio 2024-04 Setup O X

Renesas e’ studio 2024-04 Setup m 1 E N ESAS

Welcome Please read and accept the following Software Agreements

Device Families Renesas e2 studio License Terms and Conditions for RENESAS e2 studio A
OpenJDK License Agreement
ARM DS-5 Toolchain Integrat

Extra Features This Renesas e2 studio license agreement (“Agreement”) is between the

Customise ) entity on whose behalf you are entering into this Agreement (“Client”) and
Featres IAR Plugin Manager Renesas Electronics Corporation, a Japanese company with its registered
office at 3-2-24, Toyosu, Koto-ku, Tokyo 135-0061, Japan (“Renesas”). YOU
Additional SHOULD READ THIS AGREEMENT CAREFULLY, AS IT CONSTITUTES A
Software BINDING CONTRACT BETWEEN CLIENT AND RENESAS.
. The Renesas IDE Software (defined below) is intended for commercial use
@ Licenses by a company or corporation only and is not designed, developed or

produced for any private use or purpose. If you are an individual, or you
intend to install the Renesas IDE Software on behalf of an individual, or
the Renesas |DE Software is expected to be used for a private purpose
directly or indirectly, you should click "No" on the installer.

Otherwise, by clicking the "l accept” button or other button or mechanism
designed to acknowledge agreement to the terms of an electronic copy of
this Agreement, or by installing, accessing, or otherwise copying or using
all or any portion of the Renesas IDE Software, you accept this Agreement
on behalf of the entity for which you are authorized to act (e.g,, an
employer) and acknowledge that such entity is legally bound by this

Anaraamant and vnin ranracant and wiarrant that vni haus tha rinht nAwar

< >

[“]il accept the terms of the Software Agreements Print all...

< Back Install Cancel

Figure 8: Installation of e2 studio — Licenses
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7. Shortcuts
Select a shortcut name for the start menu and click the [Next] button to continue.

Note:
If e2 studio was installed in another location, it is recommended to rename it to distinguish from the
other e2 studio(s).
& Renesas e? studio 2024-04 Setup 0O %

Renesas e’ studio 2024-04 Setup o 1 E N ESAS

Welcome Shortcuts to important programs and files will be created in the following locations:

Device Families

In start menu group: |Renesas Electronics €2 studio
Extra Features

. £ Restore Default
Customise
Features

Additional
Software

Licenses

@ Shortcuts

< Back Insta Cancel

Figure 9: Installation of e2 studio — Shortcuts
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8. Summary

On the summary page, a list of components to be installed will be displayed. Please review the contents
and click the [Install] button to proceed with the installation of the Renesas e2 studio IDE.

A Renesas e? studio 2024-04 Setup

Renesas e’ studio 2024-04 Setup

Welcome
Device Families
Extra Features

Customise
Features

Additional
Software

Licenses
Shortcuts

Drivers

@ Summary

a X

RENESAS

Ready to install

Software to install:
+ Renesas e2 studio v24.4.0.R20240328-1906
¢ Java Runtime v17.0.0
« |AR Plugin Manager v1.1.0.202007251457
+ Renesas e2 studio Common Components (Lite) v24.4.0.R20240328-1906
+» Renesas e2 studio Common Components (Full) v24.4.0.R20240328-1906
+ Renesas e2 studio Common Components for ARM Devices v24.4.0.R20240328-1906
+* Renesas e2 studio Tools v24.4.0.R20240328-1906
« Renesas RZ Family Support v24.4.0.R20240328-1906
+ Renesas RZ Family Support (requiring .Net Framework) v24.4.0.R20240328-1906
» Renesas FSP Smart Configurator Core v9.5.0v20240328-0843
+ Renesas FSP Smart Configurator ARM v9.5.0.v20240327-1425
+ Renesas QE Common Components v24.4.0.R20240328-1906
« ARM DS-5 Toolchain Integration v1.0.4.v20220929-0934
s Eclipse CDT Linker Script Editor and DSL v1.0.111.v20240311-1345
+ GCC for Renesas RZ Build Support v24.4.0v20240326-1111
« GCC for Renesas RZ Support Files v24.4.0v20240328-1344
+ Just) Adoptium OpenJDK Hotspot JRE Complete v17.0.10v20240120-1143
+ Renesas Build Support Files v9.4.0v20231010-1103
+ Renesas CMake Build Support Files v9.4.0.v20231010-1103
+ Renesas Common Project Import/Export v9.5.0.v20240319-0914
+» Renesas Debug Views v9.5.0v20240313-0842
+ Renesas Debua Views (Lite) v9.5.0.v20240313-0842 n

Next > Install | Cancel

| <Back |

Figure 10: Installation of e2 studio — Summary

9. Installing...

The installation will proceed. Depending on selected items of the additional software, new dialog prompts
may appear during the installation process. Please follow the instructions provided by the installer when

this occurs.
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10.Results
If the installation has been successfully completed, you should see the following information.

4 Renesas e* studio 2024-01.1 Setup a X
2 .
Renesas e’ studio 2024-01.1 Setup - zE N ESAS
Welcome Installation of e2 studio is complete.

Revicele R es Please click OK to close.
Extra Features

Customise Launch e2 studio?
Features [ View Release Notes?
Additional [ View What's New?
Software
Licenses
Shortcuts Useful Links:
Drivers

Summary

Installing...

v202401251735 User: < Back Next > Cance

Figure 1: Results Page
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2.1.4 e2 studio installation for Linux PC
This chapter describes how to install the e2 studio IDE on Linux PC.

2.1.4.1 Prerequisite
Please download the development tool related stuff:

e SEGGER J-Link driver
Please download the driver V7.92c or after from:
https://www.segger.com/downloads/jlink/JLink_Linux x86 64.deb

e e2 studio IDE installer

The latest e2 studio IDE installer package can be downloaded from Renesas website for free. Please
check detailed information from: https://www.renesas.com/e2studio.

2.1.4.2 |Installation

This section describes the procedure of each software installation. Filename, version number and the file
path are just examples. Please replace those in accordance with your environment.

e Segger J-Link driver
Open a terminal window and enter the commands stated below:

$ sudo dpkg -i JLink Linux V792c x86_ 64.deb

If the previous installation fails with unmet dependencies, please retry as follows:

$ sudo apt-get -f install
$ sudo dpkg -i JLink Linux V792c x86 64.deb

o e2 studio

1. Run the e2 studio IDE Installer “./e2studio_installer-yyyy-mm_linux_host.run”. (Before running the
installer, check the execution permission of the installer.

2. User needs to select Install Type as shown below. In this material, it is expected that Custom Install is
selected. Then, click [Next >] to continue.

(] Renesas e? studio 2024-04 Setup [=1|E3

RENESAS

Renesas e? studio 2024-04 Setup

Install Type
Please select the e? studio installation type. Click here for help selecting a type and to see what features are included.
Select Install Type:

Lite Install (Recommended)
) This installs e studio in Lite Mode.
This mode offers a simplified experience facused on simple code editing & debugging with anly important features
Standard Install
[ ) This installs e studio in Advanced Mode.
This mode offers all extended debugging functionality and other advanced features

Custom Install
Custom installation of * studio

This mode is allows you to select which features are installed

coneel

Figure 2: Selection of Install Type
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3. User can change the install folder by clicking [Change...]. Click [Next] to continue.

Note:
1. If you would like to have multiple versions of e2 studio, please specify new folder here.
2. Multi-byte characters cannot be used for e2 studio installation folder name.

™ Renesas e studio 2024-04 Setup [@[x]

RENESAS

Renesas e? studio 2024-04 Setup

@ Welcome Install directory ready
Install Location:
[Change...]
° Prerequisite software already installed
Internet connection available
Change Proxy Settings...
Ready to install
Software to install:
+ Renesas e2 studio v24.4.0.R20240404-0837

« Java Runtime v17.0.0
= IAR Plugin Manager v1.1.0.202007251457

* Renesas e2 studio Common Components (Lite) v24.4.0.R20240404-0837
* Renesas e2 studio Common Components (Full) v24.4.0.R20240404-0837
* Renesas QE Common Components v24.4.0.R20240404-0837

* Eclipse CDT Linker Script Editor and DSL v1.0.111.v20240311-1345

* Just] Adoptium OpenJDK Hotspot JRE Complete v17.0.10.v20240120-1143
* Renesas Build Support Files v9.4.0.v20231010-1103

* Renesas CMake Build Support Files v9.4.0.v20231010-1103

* Renesas Common Project Import/Export v9.5.0.v20240319-0914

* Renesas Debug Views v9.5.0.v20240402-1238

Gancel

Figure 3: Installation of e2 studio — Welcome page

3. Device Families
Select Devices Families to install. Click the [Next] button to continue.

™ Renesas e studio 2024-04 Setup @EIx]

Renesas e? studio 2024-04 Setup

Select the device families you wish to install support for ] zE N ESAS

Welcome AW RA
RA I f RA
@ Devieelamilies Build, Debug & Code Generation support for Renesas RA devices
AW RZ
Build, Debug & Code Generation support for Renesas RZ devices

R RL78

RUT78 Debug & Code Generation support for Renesas RL78 devices

W RX

RX Build, Debug & Code Generation support for Renesas RX devices

AW RH850
RHBSO pohyg support for Renesas RHES0 devices

AW RE

Re Build & Debug support for Renesas RE devices

@ Linux on Renesas RZ
RZ Build & Debug support for Linux on Renesas RZ devices

¢dialog **

Ruild £ Nahun cunnnet far Ranacac NA davirac

- Back concel

Glr=

Select All

Figure 4: Installation of e2 studio — Device Families

4. Extra Features
Select Extra Features (i.e., Language packs, SVN & Git support, RTOS support...) to be installed. For
non-English language users, please select Language packs at this step if needed. Then, please click the
[Next] button to continue.
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] Renesas e studio 2024-04 Setup O][x
Renesas e? studio 2024-04 Setup

select the extra features you wish to install ] zE N ESAS

Welcome ~ Japanese Language Support
) (=)
Device Families
@ B FELTES Chinese (Simplified) Language Support
)
Chinese (Traditional) Language Support
=)
Git Integration
=)
Git SCM Support
— Terminals
(=)

ANSI/vt102 compatible Terminal support for Serial, ssh and Telnet

Select All

= ok cenee

Figure 5: Installation of e2 studio — Extra Features

5. Customize Features

Select the components to install and click the [Next] button to continue. Be sure that “Renesas FSP Smart
Configurator Core” is certainly selected.

(] Renesas e’ studio 2024-04 Setup =13}

RENESAS

Renesas e? studio 2024-04 Setup

welcome Select the components you want to install.

Device Families < [JRenesas RH850 Family Support (24.4.0.R20240404-0837)

EimREie ¢ [[JRenesas DA Family Support (24.4.0.R20240404-0837)

Customise
Feafniree Renesas FSP Smart Configurator Core (9.5.0.v20240403-1046)

[¥) Renesas FSP Smart Configurator ARM (9.5.0.v20240327-1425)

4 /] Renesas QE Common Components (24.4.0.R20240404-0837)
[ Git integration for Eclipse (6.8.0.202311291450-r)

4 [ Additional Tools (24.4.0.R20240404-0837)

% [[JT™ Terminal (4.6.0)

4 [))apanese Language Support (4.5.100)

% [[J chinese (simplified) Language Support (4.5.100)

4 [) Chinese (Traditional) Language Support (4.5.100)

Select All Optional | Deselect All Optional

size of install: 870.8 MB

= pack cancel

Figure 6: Installation of e2 studio — Features

6. License Agreement

Read and accept the software license agreement. Click the [Next] button. Please note that user must
accept the license agreement, otherwise installation cannot be continued.
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) Renesas e* studio 2024-04 Setup I=1E3}
Renesas e? studio 2024-04 Setup
RENESAS
Welcome Please read and accept the ing Software Agr
Device Families Renesas e2 studio License Terms and Conditions for RENESAS e2 studio

Extra Features OpenjDK License AQreeN . panesas e2 studio license agreement (*Agreement”) is

Customise ARM Ds-5 Toolchain Inte¢ between the entity on whose behalf you are entering into this

o 14R Plugin Manager Agreement (“Client") and Renesas Electronics Corporation, a
Japanese company with its registered office at 3-2-24, Toyosu,

additional Koto-ku, Tokyo 135-0061, Japan ("Renesas”). YOU SHOULD READ

Software THIS AGREEMENT CAREFULLY, AS IT CONSTITUTES A BINDING
CONTRACT BETWEEN CLIENT AND RENESAS.

@ Licenses The Renesas IDE Software (defined below) is intended for

commercial use by a company or corporation only and is not
designed, developed or produced for any private use or purpose.
If you are an individual, or you intend to install the Renesas IDE
Software on behalf of an individual, or the Renesas IDE Software
is expected to be used for a private purpose directly or indirectly,
you should click "No® on the installer.
Otherwise, by clicking the "I accept* buttan or other button or
mechanism designed to acknowledge agreement to the terms of
an electronic copy of this Agreement, or by installing, accessing,
or otherwise copying or using all or any portion of the Renesas
IDE Software, you accept this Agreement on behalf of the entity
for which you are authorized to act (e.g., an employer) and
acknowledge that such entity is legally bound by this Agreement
and you represent and warrant that you have the right, power anc
authority to act on behalf of and bind such entity (if any) and

i

I [ 1 accept the terms of the Software Agreements I Printall...

= Back - Coneel

Figure 7: Installation of e2 studio — Licenses

7. Shortcuts
Select shortcut name for start menu and click [Next] button to continue.

- Renesas e? studio 2024-04 Setup =]
Renesas e? studio 2024-04 Setup
RENESAS
Welcome Shortcuts to important programs and files will be created in the following lacations

Device Families
| i thies mpplication laimehior |
Extra Features

Customise
Features

Additional
Software

Licenses

@ Shortcuts

i Srel &

Figure 8: Installation of e2 studio — Shortcuts

8. Summary
Components list to be installed is shown. Please confirm the contents and click the [Install] button to
install the Renesas e2 studio IDE.
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jm]

Renesas e studio 2024-04 Setup

Renesas e? studio 2024-04 Setup

Ready to install
Software to install:

Welcome

Device Families

Extra Features

Customise
Features

Additional
Software

Licenses

shortcuts

@ Summary

V202404040955

[Ollx]
RENESAS

Renesas e2 studio v24.4.0.R20240404-0837

Java Runtime v17.0.0

IAR Plugin Manager v1.1.0.202007251457

Renesas e2 studio Commaon Components (Lite) v24.4.0.R.
Renesas e2 studio Common Components (Full) v24.4.0.R:
Renesas e2 studio Common Components for ARM Devices

7
-0837

v24.4.0,R20240404-0837

Renesas e2 studio Tools v24.4.0.R20240404-0837

Renesas RZ Family Support v24.4.0.R20240404-0837
Renesas FSP Smart Configurator Core v9.5.0.v20240403-1046
Renesas FSP Smart Configurator ARM v9.5.0.v20240327-1425
Renesas QE Common Components v24.4.0.R20240404-0837

+ ARM DS-5 Toolchain Integration v1.0.4.v20220929-0934
« Eclipse CDT Linker Script Editor and DSL v1.0.111.w20240311-1345
* GCC for Renesas RZ Build Support v24.4.0.v20240326-1111

User: masao

GCC for Renesas RZ Support Files v24.4.0.v20240328-1344
Just] Adoptium Open]DK Hotspot |RE Complete v17.0.10.v20240120-1143
Renesas Build Support Files v9.4.0.v20231010-1103

Renesas CMake Build Support Files v9.4.0.v20231010-1103
Renesas Commeon Project Import/Export ¥9.5.0.v20240319-0914
Renesas Debug Views v9.5.0.v20240402-1238

Renesas Debug Views (Lite) v9.5.0.v20240401-1026

Renesas QE common v2.2.1.v20240311-1519

Renesas RTOS Debug Views v9.4.0.v20231118-1122

Renesas RZ Debug Support v24.4.0.v20240227-1032

Renesas RZ Debug Support Files v24.4.0.v20240402-1657
Renesas Smart Configurator for RZ v24.4.0.v20240402-0340

< Back Cancel

Figure 9: Installation of e2 studio — Summary

9. Installing...

The installation is performed. Depending on selected items of additional software, new dialog prompts
may appear during the installation process. Please see chapter 2.1.3.2 for more detailed information.

10.Results

If the installation is successfully done, you should see the following information.

B

Renesas e* studio 2024-04 Setup

Renesas e? studio 2024-04 Setup

Welcome
Device Families
Extra Features

Customise
Features

Additional
Software

Licenses
shortcuts
summary

installing...

@ Results

[[=1[E3
RENESAS

Installation of @2 studio is complete.

Please click OK to close

Launch e2 studio?
I£3 view Release Notes?
View What's New?

Useful Links:

Figure 10: Summary Page
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2.2 Arm GNU Toolchain setup
2.2.1 Arm GNU Toolchain installation for Windows PC

1. Download installer
Download arm-gnu-toolchain-13.2.rel1-mingw-w64-i686-aarch64-none-elf.exe from the following URL:

https://developer.arm.com/downloads/-/arm-gnu-toolchain-downloads

2. Install
Launch the downloaded file and complete the installation.

2.2.2 Arm GNU Toolchain installation for Linux PC

1. Download the tarball from URL:
$ wget —--content-disposition https://developer.arm.com/-
/media/Files/downloads/gnu/13.2.rell/binrel/arm-gnu-toolchain-13.2.rell-
x86 64-aarch64-none-
elf.tar.xz\?rev\=a05df3001fa34105838e6fba79%elb23\&¢hash\=D63F63D13F01626D2070
19956E7122B5

2. Adjust the e2studio_root in the command below to correspond with the e2studio installation directory,
and then extract its contents into the [e2studio_root]/toolchains/gcc_arm_aarch64/13_2023_10
directory:

$ mkdir -p "[e2studio root]/toolchains/gcc arm aarch64/13 2023 10"
$ tar -xf arm-gnu-toolchain-13.2.rell-x86 64-aarch64-none-elf.tar.xz -C
"[e2studio root]/toolchains/gcc _arm aarch64/13 2023 107
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2.2.3 Arm GNU Toolchain registration to e2 studio
Select Help -> Add Renesas Toolchains on e2 studio.

File Edit Source Refactor Mavigate Search Project RenesasViews Run  Renesas Al Window  Help

EXXY
45 Debug X

B |

® | v Q- = 'b?o:j' Welcome

|i% § = O ||#} weh_blinkylFS (3) Help Contents

40 i Search

Z Show Context Help

Z; Show Active Keybindings... Ctrl+Shift+L

47 Cheat Sheets...

49
1 Renesas Help ]
? ##  Toolchain Help »
5
6 CMSIS Packs Management >
: ﬁ Add Renesas Toolchains
g @ Eclipse User Storan - - >
R = Integrate non-integrated toolchains

oo
k1)

G GG G WU W w DL
=~ @

[t}

~ o

]

@ ey

About e studio

-

8 Perform Setup T:

Check for Updates

Install New Software...

Eclipse Marketplace...

IAR Embedded Workbench plugin manager..

Ei ey

Figure 11: Add Renesas Toolchains Menu

Confirm 13.2.1.20231009 exists under GCC ARM A-Profile in the table. If it does not exist, press Add button
and select the directory you have installed Arm GNU Toolchain.

ﬁ Preferences

Module Download
My Renesas
Reality Al Authentica
Renesas QF
Renesas Toolchain M:
Smart Browser
Smart Configurator
Smart Demo
Smart Manual
Support Folders
Tracealyzer
TraceX

Run/Debug

Scripting

Terminal

TextMate

Tracing

Walidation

Mersion Control (Team)

XML v

< >

@Duesd ®

type filter text R Toolchain Manag
FSP ~ : 5
[AScan for installed tooichains on startup:
Launch Settings
Logging Toclchain Type

[ LLVM Embedded Toolchain for Arm
v [#] GNU ARM Embedded
12.2.1.arm-12-mpacbti-34
10.3.1.20210824

£.3.1.20170620
[] KPIT GNUARM-NONE-EABI Toolchain
[ xPack GNU ARM Embedded
~ [#/] GCC ARM A-Profile (AArché4 bare-metal)

Installation Path

C¥Program Files (x86)¥Arm GNU Toolchain arm-none-eabi¥12.2 mpacbti-rel1¥
C:¥Program Files (x86)¥GNLU Arm Embedded Toolchain¥10 2021.10%
C¥Program Files (x86)¥GNU Arm Embedded Toolchain¥s 2020-q2-update¥
C:¥Program Files (x86)¥GNU Tools ARM Embedded¥9 2019-q4-major¥
C:¥Program Files (x86)¥GNU Tools ARM Embedded¥6 2017-q2-update¥

1 13.2.1.20231009

C:¥Program Files (x86)¥Arm GNU Teolchain aarch84-none-elf¥13.2 Rel1¥ I

lw] 10.3.1.20210621

C¥Renesas¥e2 studic_2024-01%toolchains¥geoc_arm_aarc h64§1 0_2021_07¥gcc-a

Download... Scan.. Add... Remove

rm-10.2-2021.07-mingw-w64-i686-aarchB4-none-elf¥

Apply and Close Cancel

Figure 12: Renesas Toolchain Management
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2.3 FSP setup

In this section, 3 ways of FSP installation are described. However, at this moment, platform installer won't be
available and so, please install FSP based on either 2.3.2 or 2.3.3.

2.3.1 Installation of FSP Packs using Platform Installer

This section describes how to install FSP using Platform Installer setup_rzafsp_v3_0_0_e2s_v2024-04.exe
showcased at here.

1. Double-click setup_rzafsp_v3_0_0_e2s_v2024-04.exe, select either [Quick Install] or [Custom Install]

and click [Next >] when the installation wizard is shown. When you chose [Quick Install], you can jump
to 6. Licenses.

Note:
If e2 studio was installed in your PC, the option to upgrade the existing version or install e2 studio to a
different location will be displayed.

Renesas RZ/A Flexible Software Package (FSP) v3.0.0 with e? studio 2024-04  Sety
¢ P i LENESAS

Install Type
Select Install Type:

Quick Install

=/ Default installation of e studio, FSP & GCC ARM Embedded

Custom Install
X/ Custom installation of * studio, FSP & GCC ARM Embedded

Figure 13: FSP Platform Installation Wizard

2. Welcome page
User can change the install folder by clicking [Change...]. Click [Next] to continue.

Note:
1. If you would like to have multiple versions of e2 studio, please specify new folder here.
2. Multi-byte characters cannot be used for e2 studio installation folder name.

Renesas RZ/A Flexible Software Package (FSP)y3,0.0 with e’ studio 2024-04  Setup
LENESAS
@ Welcome

~

hange.]
° Prerequisite software already installed
Internet connection available
Change Proxy Settings.
Ready to install
Software to install:
« Renesas e2 studio v24.1.1.R20240125-1623

« Java Runtime v17.0.0

« Renesas FSP Smart Configurator Core v9.4.1v20240125-1542

« GCC for Renesas RZ Build Support v24.1.0420240111-1134

« Renesas RZ Common v24.1.0.v20230928-1415 4

ack Next > Insta Cancel

Figure 14: FSP Platform Installer - Welcome page
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3. Extra Features

Select Extra Features (i.e., Language packs, SVN & Git support, RTOS support...) to be installed. For
non-English language users, please select Language packs at this step if needed. Then, click the [Next]

button to continue.

Select the extra features you wish to install
Welcome
O -
@ Extra Features
O =
0 e
O -
O =
Select All

Renesas RZ/A Flexible Software Package (FSP) v3.0.0 with e’ studio 2024-04 Setu
9 * 1 KENESAS

Japanese Language Support

Chinese (Simplified) Language Support
Chinese (Traditional) Language Support
Git Integration

Git SCM Support

Terminals

ANSI/vt102 compatible Terminal support for Serial, ssh and Telnet

< Back Insta Cancel

Figure 15: FSP Platform Installer — Extra Features

4. Customize Features

Essential features have already been selected. If you would like to install additional features, please

check those and then click [Next >].

Welcome
Extra Features

Customise
Features

Renesas RZ/A Flexible Software Package (FSP) v3.0.0 with e? studio 2024-04 Setuy,
9¢ (FSP) P :RENESAS

Select the components you want to install.
Renesas e2 studio (24.1.1.R20240125-1623) A
Java Runtime (17.0.0)

Renesas FSP Smart Configurator Core (9.4.1v20240125-1542)
GCC for Renesas RZ Build Support (24.1.04+20240111-1134)
Renesas RZ Common (24.1.0.420230928-1415)

Renesas RZ Debug Support (24.1.0.420230928-1415)
Renesas RZ Debug Support Files (24.1.0v20240112-2219)

Renesas e2 studio Common Components (24.1.1.R20240125-1623)

Select All Optional  Deselect All Optiona!

Size of install: 763.1 MB

< Back Insta Cancel

Figure 16: FSP Platform Installer — Features
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5. Additional Software
All the software is selected by default. click [Next >].

Renesas RZ/A Flexible Software Package (FSP) v3.0.0 with e? studio 2024-04 Setu|
ge (FSP) F :RENESAS

Select the additional software you wish ta install

Welcome w [] Renesas RZ
T Fazens Renesas FSP for RZ/Av2.0.2 202
| mbedded 9.2. q .2.1. g
[7] GNU ARM Embedded 9.2.1 2019g4 92.1.2019g4
E““""“‘E GNU ARM Embedded 12.2-Rel1 12.2-Rell
satures GCC ARM A-Profile (AArch64 bare-metal) 10.3-2021.07 103.0.2021.07
Additional [] Renesas QE
Software

0 B download required

< Back Insta Cancel

Figure 17: FSP Platform Installer — Additional Software

6. Licenses
Please read and accept Software License Agreements to be listed and click [Next >].

Renesas RZ/A Flexible Software Package (FSP) v3.0.0 with e? studio 2024-04 Setup
LENESAS

Welcome Please read and accept the following Software Agreements
Extra Features Renesas e2 studio License Terms and Conditions for RENESAS e2 studio ~
Customise OpenJDK License Agreement

This Renesas e2 studio license agreement ("Agreement”) is between the

Features ARM DS-5 Toolchain Integrati entity on whose behalf you are entering into this Agreement ("Client”) and

Additional Renesas FSP for RZ/A v2.0.2 Renesas Electronics Corporation, a Japanese company with its registered
Software GNU ARM Embedded 9.2.1 20 office at 3-2-24, Toyosu, Koto-ku, Tokyo 135-0061, Japan ("Renesas”). YOU
GNU ARM Embedded 12.2-Re| [SHOULD READ THIS AGREEMENT CAREFULLY, AS IT CONSTITUTES A
@ Licenses GCC ARM A-Profile (AArch64 | |BINDING CONTRACT BETWEEN CLIENT AND RENESAS.

The Renesas IDE Software (defined below) is intended for commercial use
by a company or corporation only and is not designed, developed or
produced for any private use or purpose. If you are an individual, or you
intend to install the Renesas IDE Software on behalf of an individual, or the
Renesas IDE Software is expected to be used for a private purpose directly
or indirectly, you should click "No" on the installer.
Otherwise, by clicking the "I accept” button or other button or mechanism
designed to acknowledge agreement to the terms of an electronic copy of

< > | this Agreement, or by installing, accessing, or otherwise copying or using all

Renesas Common Library EUL

[]]l accept the terms of the Software Agreements Print all

< Back Insta Cancel

Figure 18: FSP Platform Installer — Licenses

7. Shortcuts
Select shortcut name for start menu and click [Next] button to continue.

Note:

If e2 studio was installed in another location, it is recommended to rename it to distinguish from the
other e2 studio(s).
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Extra Features

Customise
Features

Additional
Software

Licenses

@ Shortcuts

Renesas RZ/A Flexible Software Package (FSP) v3.0.0 with e’ studio 2024-04 Setu
9 "iRENESAS

Welcome Shartcuts to important programs and files will be created in the following locations:

In start menu group: |Renesas RZA v3.0.0

£+ Restore Default

< Back Insta Cancel

Figure 19: FSP Platform Installer — Shortcuts

8. Summary

Components list to be installed is shown. Please confirm the contents and click the [Install] button to

install the Renesas e2 studio IDE.

Welcome
Extra Features
Customise

Features

Additional
Software

Licenses
Shortcuts

Drivers

@ Summary

Renesas RZ/A Flexible Software Package (FSP) v3.0.0 with e? studio 2024-04 Setu,
i " 1CENESAS

Ready to install

Software to install:
+ Renesas e2 studio v24.1.1.R20240125-1623
« Java Runtime v17.0.0
+ Renesas FSP Smart Configurator Core v9.4.1.v20240125-1542
+ GCC for Renesas RZ Build Support v24.1.0520240111-1134
+ Renesas RZ Common v24.1.0420230928-1415
+ Renesas RZ Debug Support v24.1.0v20230928-1415
+ Just) Adoptium Open)DK Hotspot JRE Complete v17.0.8.v20230801-1951
= openjfx.media.feature v17.0.6.202303271016
+ openjfx.standard.feature v17.0.6.202303271016
+ openjfx.swing.feature v17.0.6.202303271016
+ openjfx.swt.feature v17.0.6.202303271016
« openjfx.web.feature v17.0.6.202303271016

Additional software to install:
+ Renesas FSP for RZ/A v2.0.2
+ Renesas FSP Documentation v2.0.2
+ GNU ARM Embedded 9.2.1 2019g4
+ GNU ARM Embedded 12.2-Rel1

A

I < Back | Next > Install Cancel

Figure 20: FSP Platform Installer — Summary

10.Installing...

The installation is performed. Depending on selected items of additional software, new dialog prompts
may appear during the installation process. At that time, please follow the instruction the installer

indicates.

11.Results

If the installation is successfully done, you should see the following information.
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Renesas RZ/A Flexible Software Package (FSP) v3.0.0 with e? studio 2024-04 Setu
. * RENESAS

Welcome Installation of Renesas RZ/A Flexible Software Package (FSP) v2.0.2 with e’ studio 2024-01.1 is complete.

Extra Features Please click OK to close.

Customise
Features [JLaunch e2 studio?
Additional View Release Notes?
Software View What's New?
Licenses View Renesas FSP User Manual?
Shortcuts
D
ik Useful Links:
Summary
Installing..

@ Results

Next

Figure 21: Installation Results of FSP Platform Installer

2.3.2 Installation of FSP Packs using Package Installer

Package Installer RZA_FSP_Packs_v3.0.0.exe is showcased at here. Please note that it's for Windows

Host PC only.
Here is the procedure:

1. Exit e2 studio.
2. Invoke RZA_FSP_Packs_v3.0.0.exe.
3. Click [Next >] to start the installation.

Renesas Flexible Software Package
(FSP) Installer

This installer will install FSP packs and documentation into an
existing e2 studio installation.
The documentation will be available at

<INSTALL_DIRECTORY >/fsp_documentation/rza/<VERSION

The source for FSP can be found at
https: //github.comfrenesas rza-fsp

==

Figure 22: FSP Package Installer

4. See the license term and click [| Agree] if it's acceptable
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RZA FSP v3.0.0

aRENES/AS  rease review the lcense terms before instaling Renesas RZA
F5Pv3.0.0

For use of sensor libraries you must agree to the Renesas Common Library EULA at the A
[following link:

https:/fwww.renesas. comjus/en/document/msc/disdaimer002
Scroll down to see the rest of the agreement.

|Copyright [2020-2024] Renesas Electronics Corporation and/or its affiliates. All Rights
Reserved.

[ This software and documentation are supplied by Renesas Electronics Corporation v

If you accept all terms of the agreement, dick I Agree.

< Back I Agree Cancel

Figure 23: FSP License Term

5. Specify e2 studio installation folder (e.g., C:\Renesas\e2studio) and click [Install].

Choose Install Location

& z ENES/AS  Choose the folder in which to install Renesas RZA FSP 13.0.0

The installation path must point to the root of the e2 studio instalation (e.g.
C:¥Renesas¥e2_studio). Please make sure e2 studio is dosed before installation.

Browse to folder where e2 studio is installed

CWaesae? ol

Space required: 47.5MB
Space available: 18.7 GB

<Bk Cance

Figure 24: FSP Installation

6. Click [Einish] to complete the installation.

Completing Renesas RZA FSP v3.0.0
Setup

Renesas RZA FSP v3.0.0 has been installed on your
computer.

Click Finish to dose Setup.

[ 5penup docimentaton fo s reessel |

Click here to visit the FSP GitHub repasitory

Finish

Figure 25: Completion of FSP Installation

If the box Open up documentation for this release is checked at that time, FSP documentation for the
installed version of FSP should be opened.
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2.3.3 Installation of FSP Packs using Package Zip file

No Package installer is available for Linux Host PC and therefore, you need to install FSP Packs with
RZA_FSP_Packs_v3.0.0.zip. This section describes how to do install it. Please note that the same
installation procedure is valid for Windows Host PC.

1. Download RZA_FSP_Packs_v3.0.0.zip from here.

2. Extract the zip file to e? studio installation directory.

If the FSP Packs are successfully extracted, rz_fsp/rza/packs directory is placed at the location below:
o <e? studio installation directory>/internal/projectgen

I o -1 =l L internal projectgen rz_fsp rza [EI

© Recent
@ Amazon.FreeRTOS-Kernel.10.4.3-LTS.Patch.1+fsp.1.2.1.pack 263.9 kB o)
* Starred @ Amazon.FreeRTOS-Plus-TCP.2.3.2-LTS.Patch. 1+fsp.1.2. L.pack 250.4 kB %
7 Home f@ FreeRTOS.FreeRTOS_plus_FAT.1.2.1.pack 290.6 kB A
D Documents @ Renesas.RZA.1.2.1.pack 1.5 MB o
@ Renesas.RZA_baremetal_blinky.1.2.1.pack 2.6 kB P!
\eswicads f@ Renesas.RZA_board_custom.1.2.1.pack 4.8 kB 7}
dd Music @ Renesas.RZA board_custom_octal_xip.1.2.1.pack 4.9 kB A
@ Pictures @ Renesas.RZA_board_rza3ul_smarc_octal_xip.1.2.1.pack 72.3 kB o)
@ Renesas.RZA_board_rza3ul_smarc_gspi.1.2.1.pack 70.5 kB P!
= Videos f@ Renesas.RZA_board_rza3ul_smarc_gspi_xip.1.2.1.pack 70.7 kB A
i Tash @ Renesas.RZA_config.1.2.1.pack 5.5 kB A
M thinclient drives = @ Renesas.RZA_freertos_blinky.1.2.1.pack 4.9 kB P!
B f@ Renesas.RZA_mcu_rza3ul.1.2.1.pack 287.2 kB 7}
+ Other Locations @ SEGGER JLink.7.82.3.pack 29.4MB 18 118 2022

Figure 33. FSP Packs in e2 studio installation directory

3. At the 1st invocation of e? studio after you carry out the above procedure, FSP Packs should be installed
automatically.

You can check if the installation is successfully done by the following procedure:
1. Click Help > About e? studio.

eZdud s 212301 work - e studio

File Edit Source Refactor Navigate Search Project Renesas Views Run Window | Help |

Al m|-—- No Launch Configurations on: |- & Welcome ¢
—_— = @ Help Contents
i Project Explorer x B 9 g =
5 Search
There are no projects in your workspace. Show Context Help

T = i i
o add a project Show Active Keybindings...

¢ Makefile project in a directory containing Cheat Sheets.

i ¢ C or C++ project Renesas Help b
9 Cres: D . CMSIS Packs Management »
£a Import projects & Add Renesas Toolchains

@ Eclipse User Storage 3

% Perform Setup Tasks...
“ Check for Updates
& Install New Software.
& Eclipse Marketplace..
Install New Device Family Support
4 IAR Embedded Workbench plugin manager.
I @ About e? studio I
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2. Click Installation Details.

About e” studio

Renesas e? studio

Version: 2023-01 (23.1.0)
Build Id: R20230106-1556

Parts Copyright (C) 2010-2023 Renesas Electronics
Corp.

All rights reserved.

e? studio IDE is an extension of software developed
eclipse.org.

e? studio IDE is based on Eclipse Platform 4.25

(2022-09)
and CDT version 10.7.0.

3. Click the link to e? studio support area. If the installation is successfully done, a file manager should be
invoked, and the directory specified as e? studio support area should be shown there.

e” studio Installation Details x

Installed Software |Installation History |Features Plug-ins Configuration Renesas Device Support Support Folders

e? studio support av‘ea‘lﬁlu 7 l.eclipse/com.renesas mdllulm_l.‘:gSObll?w|
e? studio download area: file:/ l.eclipsef/com.renesas.platform_download/

4. Check if FSP Packs are placed in the directory below:
o <e? studio support area>/internal/projectgen/rz_fsp/rzal/packs

.eclipse com.renes...159947646 internal projectgen rz_fsp rza packs
@ Recent
@ Amazon.FreeRTOS-Kernel.10.4.3-LTS.Patch.1+fsp.1.2.1.pack
% starred @ Amazon.FreeRTOS-Plus-TCP.2.3.2-LTS.Patch. 1+fsp.1.2.1.pack
4 Home @ FreeRTOS.FreeRTOS_plus_FAT.1.2.1.pack

[ Documents @ Renesas.RZA.1.2.1.pack

@ Renesas.RZA_baremetal_blinky.1.2.1.pack

Downloads
+ @ Renesas.RZA_board_custom.1.2.1.pack

dd Music @ Renesas.RZA_board_custom_octal_xip.1.2.1.pack
@ Pictures @ Renesas.RZA_board_rza3ul_smarc_octal xip.1.2.1.pack
@ Renesas.RZA_board_rza3ul_smarc_gspi.1.2.1.pack
v Videos L.
@ Renesas.RZA_board_rza3ul_smarc_gspi_xip.1.2.1.pack
I Trash @ Renesas.RZA_config.1.2.1.pack
M thinclient_drives & @ Renesas.RZA_freertos_blinky.1.2.1.pack
@ Renesas.RZA_mcu_rza3ul.1.2.1.pack

+ Other Locations @ SEGGER.JLink.7.82.3.pack

5. Check if xml files are placed in the folders below:
o <e? studio support area>/internal/projectgen/rz_fsp/rza/modules
o <e? studio support area>/internal/projectgen/rz_fsp/rza/3.0

.eclipse  com.renes..159947646  internal  projectgen  rzfsp  rza -
© Recent
w12
* starred B8 modules
¥ Home @ packs

D Documents
+ Downloads
43 Music

@ Pictures
' Videos

i Trash

= thinclient_drives 2

+ Other Locations
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3. Set up an SMARC EVK

Below is an example of a typical system configuration.

e? studio

(Note)

Segger J-Link

(Note) RZ/A3UL SMARC EVK
9-Pin Cortex-M Adapter
(https://www.segger.com/products/debug-probes/j-link/accessories/adapters/9-pin-cortex-m-adapter/)

Figure 26: System Configuration Example - SMARC EVK

3.1 Supported Debugger
e SEGGER J-Link
For details on SEGGER J-Link, please see J-Link Debug Probes by SEGGER — the Embedded Experts.

3.2 Board Setup

3.2.1 Boot Mode
Set up the SW11 as follows to configure Boot Mode 3 (QSPI or OCTA Boot (1.8V) Mode)/

QSPI Boot (1.8V) Mode

SW11-1 | OFF
SW11-2 | OFF
’]_H SW11-3 | OFF
SW11:Mode Se\ng switch Swii4 ON
DiIP-Switch-4pol-SMD
1Sl 8 BOOT_SELO2
et
1 4 = g VBUS_MIN
Figure 27: Boot MODE
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3.2.2 JTAG connection
When connecting JTAG, you must set the DIP SW1 settings as follows:

ARM Cortex Micro
JTAG / SWD 0.05" pitch
10pin Ribbon Cable

Connected

o
=

JTAG debug mode

Normal operation

Figure 28: JTAG connection

Please note that RZ/A3UL SMARC EVK has CoreSight 10 connector and therefore, the following adapter
must be needed to connect Segger J-Link.

https://www.segger.com/products/debug-probes/j-link/accessories/adapters/9-pin-cortex-m-adapter/

3.2.3 Debug Serial (console output)
Debug serial uses CN14. The baud rate is 115200bps.

ToPC

USB Type-microB cable

CN14: USB Type-microB Connector

Figure 29: Debug Serial (console output)
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3.2.4 Power Supply

Here are the proven power supply related goods to be used in Renesas’ development. Please prepare for
the equivalent ones for your development.

e USB Type-C cable CB-CD23BK (manufactured by Aukey)
e USB PD Charger Anker PowerPort Il 65W Pod (manufactured by Anker)

:‘ : CN6: USB Type-C Connector for Power Supply

To USB-PD
E \’ Power Charger

1
|
|
|
1
1 USB Type-C cable
1
|
1
1
1
1
|
1

Figure 30: Power Supply

For power supply, please follow the following procedure:

1. Connect USB-PD Power Charger to USB Type-C Connector (CN6).
Once USB-PD Power Charger is connected to the CN6, LED1 (VBUS PWR ON) and LED3 (Module PWR
ON) should light up.

2. Press the power button (SW9) to turn on the power
When turning on the power, you need to press and hold the power button for 1 second. Also, the power
button should be pressed and held for 2 seconds for turning off the power.

3. If the power supply is successful, LED4 (Carrier PWR On) should light up.

VBUSIR On  RESFI VBUS IR On
%) "M LEDY gi‘:q E3 M LED:

[ VBUS PR Foult |
VBUS PR Foult [ e [

3 {@@n) LED2 -
( M )GURERR R On
ol

ModlBRBAR On . [ AN . pen g
ﬁ“ﬁi‘*-:sol vy - G SO 02 . ¢
CarPIBEPHR On / A
m{? LED4 e
-

4 o

Press SW9 for a few seconds LED3 becomes lighted up

Figure 31: LED Status after Turning on EVK
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3.2.5 How to check if your board is operational
This section describes how to check if your board is operational.

1. Connect the board to your development PC as described in 3.2.3.

2. Turn on the board as described in 3.2.4.

3. Launch Terminal Software (e.g., Tera Term).

4. Establish the connection between the board and development PC as shown in figure below:

Click [New connection...]

Click [File]
Select “COM ##: USB Serial Port (COM ##) [note)

{note) The number of COM Port depends on your development PC

Figure 32: Establishment of connection between EVK and Development PC

5. You should see the following message on your Terminal Software. You can ignore the keyword “error”
since the cause of error is that nothing is programmed to QSPI Flash or OctaFlash by default.

B COM14- Tera Term VT
File Edit Setup Control Window Help

Download mode due to error
gram to System RAM ---------------

Figure 33: Message on your terminal at the 1st power-up of EVK

4. Tutorial: Your First RZ MPU Project - Blinky

4.1 Tutorial Blinky

The goal of this tutorial is to quickly get acquainted with the Flexible Platform by moving through the steps of
creating a simple application using e2 studio and running that application on an RZ MPU board.

4.2 What Does Blinky Do?

The application used in this tutorial is Blinky, traditionally the first program run in a new embedded
development environment.

Blinky is the "Hello World" of microprocessors. If the LED blinks you know that:

e The toolchain is setup correctly and builds a working executable image for your chip.

e The debugger has installed with working drivers and is properly connected to the board.
e The board is powered up and its jumper and switch settings are probably correct.

e The microprocessor is alive, the clocks are running, and the memory is initialized.

o Timer (GTM) interrupt is intentionally fired and GPIO is properly controlled.

Note:

SRMAC EVK board does not have any LED. Thus, Blinky sample application used in this tutorial is
designed to use the Pmod module described below alternatively:
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e Pmod LED (Four High-brightness LEDs):
https://reference.digilentinc.com/pmod/pmodled/start

Pmod1

Figure 34: Connection Pmod LED module (410-076)

This module is not included on the SRMAC EVK board and so, please prepare it beforehand.

4.3 Create a New Project for Blinky

The creation and configuration of an RZ/A C/C++ FSP Project is the first step in the creation of an
application. The base RZ/A pack includes a pre-written Blinky example application.

Follow these steps to create an RZ MPU project:

1. In e2 studio, click [File] > [New] > [C/C++ Project].

File | Edit Mavigate Search Project RenesasViews Run Window Help

New Alt+Shift+N > Renesas C/C++ Project »
Open File... [©] C/C++ Project

[} Open Projects from File System... Y Project.
Recent Files > B Example..
Close Editor Cirl+W [ Other.. Ctrl+N
Close All Editors Ctrl+Shift+W

T >

Figure 35: New C/C++ Project

2. Select [Renesas RZ] > [Renesas RZ/A C/C++ FSP Project] and Click Next.

) vew C/C++ Project o X
Templates for New C/C++ Project

All GNU for Renesas RZ C/C++ Executable Project  ~
CMake IS AC/C++ Executable Project for Renesas RZ using the

Make GNU ARM Embedded toolchain.

GNU for Renesas RZ C/C++ Library Project
ect for Renesas RZ using the GNU

project for Renesas RZ/G.

Renesas RZ/N C/C++ FSP Project
S Create an executable or static library CAC++ FSP
rrrrrrr fnr Ronosas RZMN e

Figure 36: Renesas RZ/A C/C++ FSP Project

3. Assign a name to this new project. Blinky is a good name to use for this tutorial.
4. Click Next. The Project Configuration window shows your selection.
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8 Renesas RZ/A C/C++ FSP Project

Renesas RZ/A C/C++ FSP Project
Project Name and Location

Project name
| Blinky |

Use default location

C\workspace\Blinky

You can download maore Renesas packs h

Figure 37 : e2 studio Project Configuration window (part 1)

5. Select the board support package corresponding to the package you would like to use, GNU ARM A-

Profile (AArch64 bare-metal) and 13.2.1 from the Device Selection drop-down list, Toolchains and
Version Selection drop-down list respectively. Then, Click [Next].

B Renesas RZ/A C/C++ FSP Project o X
Renesas RZ/A C/C++ FSP Project —
Device and Tocls Selection
Device Selection
FSP Version: |3.0.0 . |(EEEEn
Board:  ||RZ/A3UL Evaluation Board Kit QSPI Edition (eXecute-In-Place) v/
Device: RIAOTGO63UD2GEG
Core: Core 0 Device Details
Longuage:  ®C OCos TrustZone No
Pins 361
Processor Cortex-A55
< >
Toolchains Debugger
GCC ARM A-Profile (AArch64 bare-metal) J-Link ARM ~
|[13:2:1.20231009 -]
@ < Back Next > Cancel

Figure 38 : e2 studio Project Configuration window (part 2)

6. Select the Build Artifact and RTOS.
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3 Renesas RZ/A C/C++ FSP Project

Renesas RZ/A C/C++ FSP Project —
Build Artifact and RTOS Selection

Build Artifact Selection

RTOS Selection
® Executable No RTOS =
® Project builds to an executable file
O static Library

* Project builds to a static library file

O Executable Using an RZ/A Static Library
* Project builds to an executable file
= Project uses an existing RZ/A static library project

< Back Einish Cancel

Figure 39 : e2 studio Project Configuration window (part 3)

7. Select the Blinky template for your board and click Finish.

) Renesas RZ/A C/C++ FSP Project

Renesas RZ/A C/C++ FSP Project

Project Template Selection

Project Template Selection

@® (} Bare Metal - Blinky
Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks, and the C runtime environment,
[RenesasRZA.3.0.0.pack]

O

() Bare Metal - Minimal
W Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.
[Renesas.RZA.3.0.0.pack]

Code Generation Settings
Use Renesas Code Formatter

Figure 40 : e2 studio Project Configuration window (part 4)

Once the project has been created, the name of the project will show up in the Project Explorer window of
e2 studio. Now click the Generate Project Content button in the top right corner of the Project
Configuration window to generate your board specific files.
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4% [Blinky] FSP Configuration X = 0

(V]

Generate Project Content|

Summary

Project Summary

RENESAS
Board: RZ/A3UL Evaluation Beard Kit QSPI Edition (eXecute-In-Place)
Device: RYAO7TGO63U02GBG
Core: Core 0
Toolchain: GCC for Renesas RZ (A-Profile AArch64 bare-metal)
Toolchain Version: 13.2.1.20231009
FSP Version: 300
Project Type: Flat
Location: Ciiworkspace/Blinky ==

Selected software components

Simple application that blinks an LED. No RTOS included v300

RZA Cenfiguration Template File v3.00
Board Support Package Commen Files v3.00
/0 Port v3.00
Memory Management Unit v3.0.0
General Timer v300
Board support package for ROA07G063U02GBG v3.00
Board support package for RZA3UL v300
Board support package for RZ/A3UL (RZ/A3UL) - FSP Data v3.0.0

RZ/A3UL Evaluation Board Kit QSPI Edition (eXecute-In-Place) Board Support Files v3.0.0

Figure 41 : e2 studio Project Configuration tab

Your new project is now created, configured, and ready to build.

4.3.1 Details about the Blinky Configuration
The Generate Project Content button creates configuration header files, copies source files from templates,
and generally configures the project based on the state of the Project Configuration screen.

For example, if you check a box next to a module in the Components tab and click the Generate Project
Content button, all the files necessary for the inclusion of that module into the project will be copied or
created. If that same check box is then unchecked those files will be deleted.

4.3.2 Configuring the Blinky Clocks

By selecting the Blinky template, the clocks are configured by e2 studio for the Blinky application. The clock
configuration tab (see 5.2.3. Configuring Clocks) shows the Blinky clock configuration. The Blinky clock
configuration is stored in the BSP clock configuration file.

4.3.3 Configuring the Blinky Pins

By selecting the Blinky template, the GPIO pins used to toggle the LED1 are configured by e2 studio for the
Blinky application. The pin configuration tab shows the pin configuration for the Blinky application (see
5.2.4.Configuring Pins). The Blinky pin configuration is stored in the BSP configuration file.

4.3.4 Configuring the Parameters for Blinky Components
The Blinky project automatically selects the following HAL components in the Components tab:

e r_gtm
e r_ijoport
e r_mmu

To see the configuration parameters for any of the components, check the Properties tab in the HAL window
for the respective driver (see 5.2.9.Adding and Configuring HAL Drivers).

4.3.5 Where is main()?

The main function is located in <project>/rza_gen/main.c. It is one of the files that are generated during the
project creation stage and only contains a call to hal_entry(). For more information on generated files, see
Adding and Configuring HAL Drivers.
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4.3.6 Blinky Example Code
The blinky application is stored in the hal_entry.c file. This file is generated by e2 studio when you select the
Blinky Project template and is located in the project's src/ folder.

The application performs the following steps:

1. Get the LED information for the selected board by bsp_leds_t structure.

2. Set the configuration of Timer (GTM) and the callback function that is called when interrupt is fired.

3. Define the output level HIGH for the GPIO pins controlling the LEDs for the selected board.

4. Toggle the LEDs by calling “R_BSP_PinWrite((bsp_io_port_pin_t) pin, pin_level)” for writing to the
GPIO pin in callback function of GTM that is called with the specified interval.

4.4 Build the Blinky Project
Highlight the new project in the Project Explorer window by clicking on it and build it. There are three ways to
build a project:

1. Click on Project in the menu bar and select Build Project.

2. Click on the hammer icon.
3. Right-click on the project and select Build Project.

e e2studio-2022-07_work - Blinky/configuration.xml - e* studio
File_Edit Navigate Search | Project RenesasViews Run Window Help 1. Click “Hammer” Icon

& |M—T—= 77 Debu

¢ Project Explorer X

2. Right click “Blinky” and click “Build Project”.

3. Click [Project] -> Build Project

I Blinky o9 Build All Ctrl+Alt+B
I iond{ o oo 1 > |}
L ——
| Build Project Ctrl+B

Build Working Set > |
_ Evalu

Figure 42 : e2 studio Project Explorer window

Once the build is completed, a message shown below is displayed in the build Console window that displays
the final image file name and section sizes in that image:

..frza/fsp/src/bsp/emsis/Device/RENESAS/Source/program_entry.asm
..frza/fsp/src/bsp/emsis/Device/RENESAS/Source/startup.asm
Building file: ../rza/fsp/src/bsp/cmsis/Device/RENESAS/Source/system.c
..frza/fsp/src/bsp/emsis/Device/RENESAS/Source/system. c
Building file: ../ rza/fsp/src/bsp/cmsis/Device/RENESAS/Source/vector_table.asm
Building file: ../rza/board/rza3ul_smarc_qspi_xip/board init.c
Building file: ../rza/board/rza3ul_smarc_qspi_xip/board leds.c
../rza/fsp/src/bsp/cmsis/Device/RENESAS/Source/vector_table.asm
../rza/board/rza3ul_smarc_qspi_xip/board_init.c
../rza/board/rza3ul_smarc_qspi_xip/board_leds.c
Building target: Blinky.elf
aarché4-none-elf-objcopy -0 ihex "Blinky.elf”™ "Blinky.hex™
aarché4-none-elf-size --format=berkeley "Blinky.elf"”

text data bss dec hex filename

11924 6736 21649308 2183648 2151d8 Blinky.elf

19:52:34 Build Finished. @ errors, @ warnings. (toock 6s5.813ms)

Figure 43 : e2 studio Project Build console

4.5 Debug the Blinky Project

4.5.1 Debug prerequisites
To debug the project on a board, you need
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e The board to be connected to e2 studio
e The debugger to be configured to talk to the board
e The application to be programmed to the microprocessor

Applications run from the internal ram or external ram of your microprocessor. To run or debug the
application, the application must first be programmed to ram by JTAG debugger. SMARC EVK board has an
JTAG header and requires an external JTAG debugger to the header.

4.5.2 Debug steps
To debug the Blinky application, follow these steps:

1. Configure the debugger for your project by clicking [Run] > [Debugger Configurations...].

Run Window Help

| Renesas Debug Tools >
Q, Run Ctrl+F11
%& Debug F11
I
Run History >
Q RunAs >

Run Configurations...

Debug History >
ke A >
Debug Configurations...
3
1 @ External Tools >

Figure 44 : e2 studio Debug icon

or by selecting the drop-down menu next to the bug icon and selecting [Debug Configurations...].

no launch history

Debug As >
I Debug Configurations... I

Organize Favorites...

Figure 45 : e2 studio Debugger Configurations selection option
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2. Select your debugger configuration in the window. If it is not visible, then it must be created by clicking the
“New” icon in the top left corner of the window. Once selected, the Debug configuration for your Blinky
project should be displayed.

e Debug Configurations

Create, manage, and run configurations @

B %2 X[ B 7~ | Neme [Blinky Debug flat |

‘W‘PE:“ZE' text | _ %5 Debugger | [ Startup | [] Common | % Source
[E] C/C++ Application
[E] C/C++ Remote Application
] EASE Script [ Blinky Browse...
[E] GDB Hardware Debugging || | C/C++ Application:
[E] GDB OpenOCD Debugging
[£] GDB Simulator Debugging (1
5 Java Applet Variables... Search Project... Browse...
[T Java Application
@ Launch Group
T Remote Java Application Build Configuration: | Use Active ~
+ [c7] Renesas GDB Hardware Deb

Project:

[ Debug/Blinky.elf

Build (if required) before launching

[ Blinky Debug_Flat (O Enable auto build () Disable auto build
[E7] Renesas Simulator Debuggir (®) Use workspace settings Configure Workspace Settings...
< >
Revert Apply
Filter matched 13 of 15 items == APPIY
@ Close

Figure 46 : e2 studio Debugger Configurations window with Blinky project (1)

3. If you have selected the QSPI Edition of the SMARC EVK board, skip to Step 8. If you have selected the
OCTAL Edition of the SMARC EVK board, Select the debug configuration for the generated project and
select the Debugger tab.

=

| Edit Renesas GDB Hardware Debugging configuration Blinky Debug_Flat for Debug

Launch Configuration Name: ‘ Blinky Debug_Flat

|| E Main & Startup| & Common | ¥ Source

Debug hardware: J-Link ARM v | Target Device: RIA07G063U

GDB Settings Connection Settings Debug Tool Settings

Figure 47 : e2 studio Debugger Configurations window with Blinky project (2)
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4. Select the Connection Settings tab inside the Debugger tab.

i Name: lBIinky Debug_Flat
| Bl Main E Debugger | Startup| B, Source| Common |

Debug hardware: |J-Link ARM v | Target Device: | ROA07G063U02GBG

GDB Settings| Connection Settings | Debug Tool Settings
v J-Link A

Figure 48 : e2 studio Debugger Configurations window with Blinky project (3)

5. Change Reset after download to Yes.

Name: lBIinky Debug_Flat
l__l Main gDebuggeﬂ [= Startupi B Source{ | Common.—

Debug hardware: |J-Link ARM v | Target Device: | R9A07G063U02GBG

GDB Settings Connection Settings Debug Tool Settings

v J-Link A
Type USB v
J-Link Serial (Auto)
Settings File ${workspace_loc:/${Projh ...
Script File
Log File ${workspace_loc:/${Projh ...
Low Power Handling No v

v IP Connection
Connection Method P via LAN
Host Name/IP Address[:port number]

Identifier
Tunnel Server
Port Number
Password

v Interface
Type JTAG v
Speed (kHz) 15000 v

v JTAG Scan Chain
Multiple Devices No v
IRPre 0
DRPre 0

v Connection
Register initialization No v
Reset at the beginning of connection Yes v
Reset at the end of connection No v
Reset before download No v
Reset after download Ves Iv
ID Code (Bytes) FFFFFFFFFFFFFFFFFFFFFF ...

Figure 49 : e2 studio Debugger Configurations window with Blinky project (4)
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6. Select the Debug Tool Settings tab inside the Debugger tab.

& tdit Configuration X

Edit Renesas GDB Hardware Debugging configuration Blinky Debug_Flat for Debug

Launch Configuration Name: | Blinky Debug_Flat

Main| % Debugger| # Startup| & Common & Source

Debug hardware: J-Link ARM ~  Target Device: RIA07G063U

GDB Settings Connection Settings | Debug Tool Settings

wr 1M

Figure 50 : e2 studio Debugger Configurations window with Blinky project (5)

7. Change Flash Bus Type to OctaBus (At this time, Flash Memory Type is automatically changed to
OctaFlash).

& cdit Configuration X

Edit Renesas GDB Hardware Debugging configuration Blinky Debug_Flat for Debug

Launch Configuration Name: | Blinky Debug_Flat

Main % Debugger | # Startup| & Common % Source

Debug hardware: J-Link ARM ~ | Target Device: ROA07G063U

GDB Settings Connection Settings Debug Tool Settings

v 10
es v
IO Filename ${support_area_loc}
v General Debug
Reset After Reload Yes v
v Memory
Endian Little Endian v
v Break
Use Flash Breakpoints Yes v
Allow Simulation No v
v Flash
Flash Bus Type OctaBus V]
Flash Memory Type OctaFlash Vi

WorkRam Start

Figure 51 : e2 studio Debugger Configurations window with Blinky project (6)
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8. Select the debug configuration for the generated project and select the Startup tab.

Launch Configuration Name: I Blinky Debug_Flat

Edit Renesas GDB Hardware Debugging configuration Blinky Debug_Flat for Debug

Initialization Commands

[E) Main | ¥ Debuggerl [ Stanuplfl Common | & Source

Figure 52 : e2 studio Debugger Configurations window with Blinky project (7)

9. Be sure to change the setting in Load type field of Program Binary [Blinky... raw from Image and

Symbols to Symbols only.

Edit Renesas GDB D.

guration Blinky Debug_Flat for Debug

Launch Confiquration Name: | Blinky Debug_Flat

< Edit Configuration X

[5] Main | %% Debugger | B Startup| [[] Commen | & Source
Initialization Commands
[ Reset and Delay (secondsk: =
I Halt

Load image and symbols

Filename Load type Offset{hex)  On connect

| Edl Program Binary [Blinky...] Image and Symbols | Ves

Add...

»

Edit Renesas GDB Hard: D

Launch Configuration Name: | Blinky Debug_Flat

ion Blinky Debug_Flat for Debug

[} Main | %5 Debugger | @ Startup | [T] Common | & Source
Initialization Commands
[J Reset and Delay {seconds): 3

| [JHalt

Load image and symbols

Filename Load type

Symbols only
Image and Symbols

llm?e Onlé

F4 Program Binary [Blinky....

v

Offset (hex)  On connect

Add...
Yes

Figure 53 : e2 studio Debugger Configurations window with Blinky project (8)
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10.Click on Add... to launch Add download module window. Then click Workspace..., choose
rza3ul_smarc_qspi_ipl.srec(*) as module to be downloaded and finally click on OK.

* If you have selected "RZ/A3UL Evaluation Board Kit OCTAL Edition (eXecute-In-Place)" in board
selection, use "rza3ul_smarc_octal_ipl.srec" instead.

« Edit Configuration

Edit Renesas GDB Hardware Debugging configuration Blinky Debug_Flat for Debug

Launch Configuration Name: | Blinky Debug_Flat

[) Main | % Debugger | # Startup | 7] Common | &, Source
Initialization Commands
[JReset and Delay (seconds): e Add download module
O Halt

Specify download module name:

' Veriables... | | Search Project... | File System...
Load image and symbols
Filename Load type Offset (hex)  On connect IT‘ s Cancel
[ Program Binary [Blinky.... Symbols only v Yes
Edit '
¢ Add download module =] X

Select a workspace resource

v (5 Blinky ~
(&> settings
= Debug
v 5 ipl
e Add download module an rzadul_smarc_gspi_ipl.elf
rza3ul_smarc_gspi_ipl.srec
Specify download module name:

S{workspace_loc:¥Blinky¥ipl¥rza3ul_smarc_gspi_ipl.srec)

_cfg
' ‘ & cage
Variables... Search Project... File System... & scnpt

& s
.api_xml

project

.secure_azone

=

=

secure_xml

Figure 54 : e2 studio Debugger Configurations window with Blinky project (9)
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11.Again, click on Add... to launch Add download module window. Then click Workspace..., choose
BLINKY.srec as module to be downloaded and finally click on OK.

Edit Renesas GDB Hardware Debugging configuration Blinky Debug_Flat for Debug

Launch Confiquration Name: | Blinky Debug_Flat

[ Main | % Debugger | B Startup| [] Common| & Source
Inibalization Commands
[JReset and Delay (seconds):
[JHait

Specify download madule name:

L J oepr—"—— p—
Load image and symbols

Filename Losd type Offset (hex)  On connect I ITll " Cancel
[ Program Binary [Blinky... Symbos oaly Yes

B ol smerc cupiipls... bmsgrandSymboks 0 Yes

Move down Select 3 workspace resource

v 5 Blinky

&5 ragen
Specify download module name:

o
$iworkspace._loc: ¥Blinky¥Debug¥Blinky.srec

8 Blinky.bin
S Blinky.elf
Vorisbles.. | | Search Project... File System..

Blinky.eltin
Blinky.m
] = s

makefile.init

memory_regionsid

’ =

Figure 55: e2 studio Debugger Configurations window with Blinky project (10)

12.Then, click Debug button.

Create, manage, and run configurations. . @
LR Mome: [Biinky Debug_Flat
Main | 2 Debugoes [ ) Common| % Source
Inetialization Commands.
[ Reset and Delay (seconds)
OHak
08 Simulator Debugging (RHESO)
va Applet
[T Jova Application
3 L Load image and symbols
T, Remote lova Application
v ¥ Renesas GD8 Hasdware Debugging Filename Load type Offset (hex)  On connec
7 Blinky Debug _Flat B3 Program Binary [Blinky... Symbols enly Yes
= 33_rpmsg_demo Debug Flat & m _ipls.. ImageandSymbols 0 Yes
9 rav2l_em33_rpmsg_demo Release_Flt [ Blinkysrec [CAwork¥R... Image and Symbols 0 Yer
| Debug _Flat
7 twte Debug_Flat
[ Renesas Simulator Debugging (RX, RL7S)
Move down
Runtime Options
]Set program counter at (hex
[ Set breakpoint at: main
[JResume
Run Commands
< >
Filter matched 17 of 19 tems s hook
a con

Figure 56: e2 studio Debugger Configurations window with Blinky project (11)
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13.Debug session is now started.

e Progress Information

\-.I Launching Blinky Debug_Flat

Configuring GDB

Cancel Details »>

Figure 57: e2 studio Debugger Configurations window with Blinky project (12)

14.1f you see the following window, please click Switch to continue.

¢ Confirm Perspective Switch

e‘ This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective supports application debugging by providing views for
displaying the debug stack, variables and breakpoints.

Switch to this perspective?

[J Remember my decision

|

Figure 58: e2 studio Debugger Configurations window with Blinky project (13)

4.6 Details about the Debug Process

In debug mode, e2 studio executes the following tasks:

1. Downloading the application image to QSPI/OctaFlash ROM or DDR SDRAM.
2. Setting a breakpoint at main().
3. Setting the stack pointer register to the stack.

This section describes the detail on the debug process of Blinky Project.

4.6.1 Run the Blinky Project
Click [Run] > [Resume] or click on the Play icon shown below:

L U

Figure 59 : e2 studio Debugger Play icon

Make sure the box Set breakpoint at: is checked and specify main as its value, Program Counter should be
stopped at main() function.
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Main | %% Debugger | = Startup| ] Common | % Source
Initialization Commands

[JReset and Delay (seconds): =
[Halt

Load image and symbols

Filename Load type Offset (hex)
Program Binary [barem... Symbols only
rzadul_smarc_gspi_ipl.s.. Image and Symbols 0
baremetal_blinky_new.s... Image and Symbols 0

On connect
Yes
Yes

Yes

Runtime Options
[ set program counter at (hex):

I Set breakpoint at: main | I
[JResume

Figure 60 : Set breakpoint at: option

";E} [Blinky] FSP Configuration [c]0x12018 [g] hal_entry.c L€} main.c X
* generated main source file - do not edit */
#include "hal data.h"
= int main(void)

{

hal_entry ();
Teturn o;

}

Figure 61 : Blinky project in Debug Mode

After that LED on the Pmod LED should start to blink when clicking [Run] > [Resume] or Play icon again.
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5. FSP Application Launch with e2 studio

5.1 Create a Project

5.1.1 What is a Project?
In e2 studio, all FSP applications are organized in RZ MPU projects. Setting up an RZ MPU project involves:

1. Create a Project
2. Configuring a Project

These steps are described in detail in the next two sections. When you have existing projects already, after
you launch e2 studio and select a workspace, all projects previously saved in the selected workspace are
loaded and displayed in the Project Explorer window. Each project has an associated configuration file
named configuration.xml, which is in the project's root directory.

{5 Project Explorer X = 8 g a]
v 15 Blinky
& Binaries
wil Includes
@ rza
(& rza_gen
& sre
(& Debug
& ipl
(& rza_cfg
& scnpt
Blinky Debug_Flat.jlink
Blinky Debug_Flat.launch
49 configuration.xml

ROA07G063U02GBG.pincfg

598

Figure 62 : e2 studio FSP Configuration Perspective

Double-click on the configuration.xml to open the RZ MPU Project Editor. To edit the project configuration,

make sure that the FSP Configuration perspective shown below is selected in the upper right-hand corner
of the e2 studio window. Once selected, you can use the editor to view or modify the configuration settings

associated with this project.

5 | @ C/C++ {5 FSP Configuration

Figure 63 : e2 studio FSP Configuration Perspective
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Note:
Whenever the RZ project configuration (that is, the configuration.xml file) is saved, a verbose RZ
Project Report file (rza_cfg.txt) with all the project settings is generated. The format allows differences
to be easily viewed using a text comparison tool. The generated file is located in the project root
directory.

«  e2studio-2022-07_work - Blinky/rza_cfg.txt - € studio

File Edit Navigate Search Project RenesasViews Run Window Help

A |4 || @ | |25 Debug ~ || [E9 Blinky Debug_Flat v Sk ©-R-5iWEIR

¢ Project Explorer X = O {5 [Blinky] FSP Configuration  [=REPRaI RIS

= > 3 1 FSP Configuration

S BI g : 2 Board "RZ/A3UL Evaluation Board Kit QSPI Edition (eXecute-In-Place)”
¥ 55 Blinky [Debug 3 RIAGTGEE3UB2GEG
%a Binaries 3 part_number: R9AB7GO63U02GBG
B Includes 5 rom_size bytes: @
Bm € ram_size_bytes: 131672
(3 rza_gen 7 pac:age_sfyle; LFBGA
& s 8 package_pins: 361
& Debug 10 RZA3UL
& ipl 11 series: 2|
& racfg i y
& script S W RzA3UL Family

; i RZ/A3UL Common
“| Blinky Debug_Flatjlink g Secure stack size (bytes): @x2ee
X] Blinky Debug_Flat. Main stack size (bytes): @x26@
48k configuration.; 1 Heap size (bytes): @
3| ReA07GoG3URHGBG. pincig 1 MCU Vee (mv): 3300
] Parameter checking: Disabled
Assert Failures: Return FSP_ERR_ASSERTION

Figure 64 : RZ Project Report

The RZ Project Editor has several tabs. The configuration steps and options for individual tabs are discussed
in the following sections.

Note:

The tabs available in the RZ Project Editor depend on the e2 studio version and the layout may vary
slightly, however the functionality should be easy to follow.

{5} [Blinky] FSP Configuration X = 0
Summary Generate Project Content
Project Summary
RENESAS
Board: RZ/A3UL Evaluation Board Kit QSPI Edition (eXecute-In-Place)
Device: R9A07G063U02GBG
Core: Core 0
Toolchain: GCC for Renesas RZ (A-Profile AArch64 bare-metal)
Toolchain Version: 13.2.1.20231009
FSP Version: 3.00
Project Type: Flat
Location: C:/workspace/Blinky =
Simple application that blinks an LED. No RTOS included. v3.0.0
RZA Configuration Template File v3.0.0
Board Support Package Common Files v3.00
1/0 Port v3.00
Memeory Management Unit v3.00
General Timer v3.0.0
Board support package for ROA07G063U02GBG v3.0.0
Board support package for RZA3UL v3.0.0
Board support package for RZ/A3UL (RZ/A3UL) - FSP Data v3.0.0

RZ/A3UL Evaluation Board Kit QSPI Edition (eXecute-In-Place) Board Support Files v3.0.0

Q02O

ISummary BSP| Clocks | Pins | Interrupts | Event Links | Stacks Componentsl

Figure 65 : RZ Project Editor tabs
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5.1.2 Creating a New Project
For RZ MPU applications, generate a new project using the following steps:

1. Click on [File] > [New] > [C/C++ Project].

File Edit Mavigate Search Project RenesasViews Run Window Help
New Alt+Shift+N > Renesas C/C++ Project > K
Open File... [©] C/C++ Project
(L Open Projects from File System... % Project...
Recent Files > 9 Example..
Close Editor Ctrl+W 9 Other. Cirl+N

Close All Editors Ctrl+Shift+W

Figure 66 : New RZ MPU Project

2. Click on the Renesas RZ/A C/C++ FSP Project template for the type of project you are creating.

Q New C/C++ Project O

Templates for New C/C++ Project

All
CMake
Make

Renesas RZ

GNU for Renesas RZ C/C++ Executable Project
FE==™ A C/C++ Executable Project for Renesas RZ using the
GNU ARM Embedded toolchain.

GNU for Renesas RZ C/C++ Library Project

=N A C/C++ Library Project for Renesas RZ using the GNU
ARM Embedded toolchain.

~

Renesas RZ/A C/C++ FSP Project
E===S. Create an executable or static library C/C++ FSP
project for Renesas RZ/A.

enesas ++ roje
PS8 Create an executable or static library C/C++ FSP
project for Renesas RZ/G.

Renesas RZ/N C/C++ FSP Project
F====~ Create an executable or static library C/C++ FSP

nroiert far Renesas R7 /N

< Back Cancel

Figure 67 : New Project Templates
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3. Select a project name and location.

@ Renesas RZ/A C/C++ FSP Project a X

Renesas RZ/A C/C++ FSP Project

Project Name and Location

Broject name
[Briniof

Use default |

You can download more Renesas packs here

2 <Back E Cance

Figure 68 : RZ MPU Project Generator (Screen 1)

4. Click [Next].

5.1.2.1 Selecting a Board and Toolchain
In the Project Configuration window select the hardware and software environment:

1. Select the FSP version.

2. Select the Board for your application. You can select an existing RZ MPU Evaluation Kit or Custom User
Board for any of the RZ MPU devices with your own BSP definition. (Please refer 2.1.2.1 for more
information about the RZ MPU Evaluation Kit.)

3. Select the Device. The Device is automatically populated based on the Board selection. Only change
the Device when using the Custom User Board QSPI Boot (eXecute-In-Place) board selection.

4. To add threads, select RTOS, or No RTOS if an RTOS is not being used.
5. The Toolchain selection defaults to GNU ARM A-Profile (AArch64 bare-metal).
6. Select the Toolchain version. This should default to the installed toolchain version.
7. Select the Debugger. The J-Link Arm Debugger is preselected.
8. Click Next.
{8 Renesas RZ/A C/C++ FSP Project m] X
Renesas RZ/A C/C++ FSP Project —
Device and Tools Selection
Device Selection
FSP Version: |3.0.0 o Board Description
Board: RZ/A3UL Evaluation Board Kit QSPI Edition (eXecute-In-Place) v
Device: R9A07G063U02GBG
Core: Core 0 Device Details
Language: @ C OC++ TrustZone No
Pins. 361
Processor Cortex-A55
< >
Toolchains Debugger
GCC ARM A-Profile (AArch64 bare-metal) J-Link ARM ~
13.2.1.20231009 ~
?' < Back Next > FEinish Cancel
Figure 69 : RZ MPU Project Generator (Screen 2)
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5.1.2.2 Selecting a Project Template
In the next window, select the build artifact and RTOS.

8 Renesas RZ/A C/C++ FSP Project

Renesas RZ/A C/C++ FSP Project —
Build Artifact and RTOS Selection

Build Artifact Selection RTOS Selection

@® Executable No RTOS v
o Project builds to an executable file
O static Library
o Project builds to a static library file
O Executable Using an RZ/A Static Library
« Project builds to an executable file
o Project uses an existing RZ/A static library project

<Back Next > Einish Cancel

Figure 70 : RZ MPU Project Generator (Screen 3)

In the next window, select a project template from the list of available templates. By default, this screen

shows the templates that are included in your current RZ/A MPU Pack. Once you have selected the
appropriate template, click Finish.

Note:

The tabs available in the RZ Project Editor depend on the e2 studio version and the layout may vary
slightly, however the functionality should be easy to follow.

or

oot SO I @

Figure 71 : RZ MPU Project Generator (Screen 4)

When the project is created, e2 studio displays a summary of the current project configuration in the RZ MPU
Project Editor.
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3¢ [Blinky] FSP Configuration = 0
Summary Generate Project Content
Project Summary
RENESAS
Board: RZ/A3UL Evaluation Board Kit QSPI Edition (eXecute-In-Place)
Device: ROAQTG063U02GBG
Core: Core 0
Toolchain: GCC for Renesas RZ (A-Profile AArch64 bare-metal)
Toolchain Version: 13.2.1.20231009
FSP Version: 300
Project Type: Flat
Location: C:/workspace/Blinky =/

Selected software components

Simple application that blinks an LED. No RTOS included v30.0
RZA Configuration Template File v30.0
Board Support Package Common Files v30.0
/0 Port v3.00
Memory Management Unit v300
General Timer v300
Board support package for ROA07G083U02GBG v30.0
Board support package for RZA3UL v300
Board support package for RZ/A3UL (RZ/A3UL) - FSP Data v300

RZ/A3UL Evaluation Board Kit QSPI Edition (eXecute-In-Place) Board Support Files v3.0.0

Figure 72 : RZ MPU Project Editor and available editor tabs

o With the Summary tab, you can see all they key characteristics of the project: board, device, toolchain,
and more.

o With the BSP tab, you can change board specific parameters from the initial project selection.

o With the Clocks tab, you can configure the MCU clock settings for your project.

¢ With the Interrupts tab, you can add new user events/interrupts.

¢ With the Stacks tab, you can add and configure FSP modules. For each module selected in this tab, the
Properties window provides access to the configuration parameters, interrupt selections.

o The Components tab provides an overview of the selected modules. Although you can also add drivers
for specific FSP releases and application sample code here, this tab is normally only used for reference.

The functions and use of each of supported tabs is explained in detail in the next section.

Please note that RZ/A FSP doesn’t support Event Links tab and so, those tabs are grayed out as shown
above.
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5.2 Configuring a Project

Each of the configurable elements in an FSP project can be edited using the appropriate tab in the RZ
Configuration editor window. Importantly, the initial configuration of the MPU after reset and before any user
code is executed is set by the configuration settings in the BSP tab. When you select a project template
during project creation, e2 studio configures default values that are appropriate for the associated board.
You can change those default values as needed. The following sections detail the process of configuring

each of the project elements for each of the associated tabs.

5.2.1 Summary Tab

¥ [Blinky] FSP Configuration X

Summary

Project Summary

Board: RZ/A3UL Evaluation Board Kit QSP| Edition (eXecute-In-Place)
Device: ROAQ7G063U02GBG

Core: Core 0

Toolchain: GCC for Renesas RZ (A-Profile AArchB4 bare-metal)
Toolchain Version: 132120231009

FSP Version: 3.00

Project Type: Flat

Location: C:/workspace/Blinky ==/

Selected software components

Simple application that blinks an LED. No RTOS included

RZA Configuration Template File

Board Support Package Common Files

1/Q Port

Memory Management Unit

General Timer

Board support package for RGA07G063U02GBG

Board support package for RZA3UL

Board support package for RZ/A3UL (RZ/A3UL) - FSP Data

RZ/A3UL Evaluation Board Kit QSPI Edition (eXecute-In-Place) Board Support Files

o|2[9

Summary | BSP| Clocks | Pins | Interrupts | Event Links | Stacks | Components

v3.00
v3.0.0
v3.0.0
v3.0.0
v3.0.0
v3.00
v3.0.0
v3.0.0
v3.0.0
v3.0.0

= a

Generate Project Content

RENESAS

Figure 73 : Configuration Summary tab

The Summary tab, seen in the above figure, identifies all the key elements and components of a project. It
shows the target board, the device, toolchain and FSP version. Additionally, it provides a list of all the
selected software components and modules used by the project. This is a more convenient summary view

when compared to the Components tab.
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5.2.2 Configuring the BSP

The BSP tab shows the currently selected board (if any) and device. The Properties view is located in the
lower left of the Project Configurations view as shown below:

Note:
If the Properties view is not visible, click Window > Show View > Properties in the top menu bar.
[Summary BSP |Clocks | Pins| Interrupts | Event Links | Stacks | Components
[C] Properties X |I®] Problems @ AN-h:J571f- ¢ = 08 (e

RZ/A3UL Evaluation Board Kit QSPI Edition (eXecute-In-Place)

Settings Property Value

v R9A07G063U02GBG
part_number ROA07G063U02GBG
rom_size_bytes 0
ram_size_bytes 131072
package_style LFBGA
package_pins 361

v RZ/A3UL Common
Secure stack size (bytes) 0x200
Main stack size (bytes) 0x200
Heap size (bytes) 0
MCU Vec (mV) 3300
Parameter checking Disabled
Assert Failures Return FSP_ERR_ASSERTION
Error Log No Error Log
PFS Protect Enabled
C Runtime Initialization Enabled

v RZA3UL
series 2

Figure 74 : Configuration BSP tab

The Properties view shows the configurable options available for the BSP. These can be changed as
required. The BSP is the FSP layer above the MPU hardware.

When you click the Generate Project Content button, the BSP configuration contents are written to
rza_cfg/fsp_cfg/bsp/bsp_cfg.h This file is created if it does not already exist.

Warning:
Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked.

5.2.3 Configuring Clocks

The Clocks tab presents a graphical view of the MPU's clock tree, and each HAL driver uses the settings for
dedicated numerical calculation. For example, scif uart driver calculates the communication rate from the
settings in Clocks tab. Please note that PLLs should be configured by IPL and therefore, PLL settings should
be consistent with those in IPL.
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¥ [Blinky] FSP Configuration

=)
Clocks Configuration Generate 0 Content
[T Restore Defaults
OSC 24MHz == PLL1 1GHz ICLK D /1 v — LK 1GHz
= PLL2 1600MHz2 — Div /2 B00MHz T Dive /2 400MHz
= PLL2 533MHz SDOCLK Sek S313MHz  ~ — SDOCLK S33MHz
 Div /2 266500kHz2 " SDICLK Sek 533MHz  ~ — SDICLK 533MHz
> Div /8 100MHz [ Rt w — POCLK 100MHz
i /10 80MHz R —————b e
= PLLY 1600MHz —» Div /2 800MHz ~— Diw /2 400MHz - = ATCLK 400MHz
» Di /4 200MHz 2CLE Dvw /1 v — (1K 200MHz
" PACLE Div /1 w — PICLE 200MHz

e MOCLK 200MHz

D /2 100MMz — ZTCLK 100MHz
P2CLE Div /1 v s P2CLE 100MHz
[ PLL3 533MHz = PLL3 356k 533MHz  ~ —> PLL3 3 DWv /2 »e —3 Div /2 133250kHz — SPIOCLK 133250kHz
+ PLL3 400MHz = [ 21 OSD;:-_Sl'::l K BEA25KE
Do /2 66625kHz — SPNCLK 65625k Mz
Dov /2 266500kHz . M2CLK, 266500k H
PLLY S Sek: 400MHz  ~ —= PLL3 5 D /1 e i D /2 200MHz — OCOCLK 200MHz
\ Oeta QSPI0_SPCLE 10001
= Div /1000 - Déw /2 100MHz —» OCICLK 100MHz
+ PLL4 1600MHz = Sek: OSC D /1000 w b Diw /2 12kHz —_— 500K 12k
> PLLS 1500MHz + DSLA Dw /2 = Diw /1 T50MHz > MICLK TS0MHz
* PLLS S00MHz — Div /2 250MHz
= PLLG 500MHz — Div /2 250MHz — PLLG_2 Sek 250MHz (i v —————————————————— HPCLK 250MH:z
Sumimary | B5P| Pins Intermupts | Evert Stacks | Components

Figure 75 : Configuration Clocks tab

When mousing over the blocks of PLLs on clocks tab, you should see the pop-up message describing this
precaution.

O5C 24MHz PLLT 1GHz ICLK Div

This BSP does not support this configuration change.
PLLz 1600m | ©nly when changing the setting in IPL, edit PLL frequency depending on IPL setting,

Figure 76 : Precautions for PLL settings

When you click the Generate Project Content button, the clock configuration contents are written to:
rza_gen/bsp_clock_cfg.h

This file will be created if it does not already exist.

Warning:
Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked.
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5.2.4 Configuring Pins

The pins tab provides flexible configuration of the MPU’s pins. As many pins can provide multiple functions,
they can be configured on a peripheral basis. For example, selecting a serial channel via the SCIF peripheral
offers multiple options for the location of the receive and transmit pins for that module and channel. Once
pins are configured, it is shown as green in the FSP Visualization view.

[T tBinky] FsP Configuration |
Pin Configuration
Select Pin Configuration
[RZASUL-SMARC-QSPI-XIP_ v
[ Generate data: |g_bsp_pin_cfg

PinSelecton = & - %

SCIF4_RXD
SCIF4_SCK
SCIF4_TXD

<

Module name:  SCIF4

Pin Function | Pin Number
Summary |59 | Clocks [ Pins Jinterrupts| Eve

* K

- o
Q 5[
L) Export to CSV file Configure Pin Driver Wamings

41 Cycle Pin Group

Value Lock  Link

Stacks Components

§ = O |igPinConficts X |E Console 5 Debug

» Legend

il Pin Function ~

-0000000O&- -
~000000000s- 0

=~ 000000000

(>

) Module Name ~

Figure 77 : Pin Configuration

The pin configurator includes built-in conflict checker. So, if the same pin is allocated to another peripheral or
I/O function, the pin will be shown as red in the FSP Visualization view and with white cross in a red square
in the Pin Selection pane and Pin Configuration pane in the main Pins tab.

In the example shown below, port P13_1 is already used by the Display, and the attempt to connect to this
pin to the Serial Communication Interface with FIFO (SCIF) results in dangling connection error. To fix this
error, select another port from the pin drop-down list or disable the Display.

¥ *[Blinky] FSP Configuration

= a8

Pin Configuration

Select Pin Configuration

[RzasuL-smarC-ase x|

i= @ [0 [% PinConfiguration

Pin Selection

| Manage configurations..

Generate Project Content

[y Export to CSVfile 5] Configure Pin Driver Warnings

7} Cycle Pin Group

Mame

~ @ Peripherals -
AnalogiADC
+ Audio:SSI
Connectivity:CAN

Pin Group Selection
Operation Mode
v Input/Output
SCIF1_CTS

+ Connectivity:ETHE SCIFLRTS
@ ConnectivityRIIC SEALD
ConnectivityRSPI SCIF1_SCK
STFLTXD

Connectivity:SCl
v @ Connectivity:SCIF
v sCFo
@ sar

sarz

<

Value
Mixed
Custom

Lock  Link

None
None
@ P )
None
None

saFz
SCIFa
¥ ConnectivitiUSB
>

Module name:  SCIF1

<

Pin Function | Pin Number

Summary |BSP | Clocks | © Pins| Interrupts

Event Links | Stacks | Components

Figure 78 : e2 studio Pin Configurator

When you click the Generate Project Content button, the pin configuration contents are written to:
ra_gen\bsp_pin_cfg.h. This file will be created if it does not already exist.

Warning:

Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked.
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5.2.5 Configuring Interrupts from the Stacks Tab

You can use the Properties view in the Stacks tab to enable interrupts by setting the interrupt priority.
Select the driver in the Stacks pane to view and edit its properties.

v % HAL/Commen e e -
42 g_ioport [/O Port Driver on r_ioport & %!opnrt I"Q Port ~+ g_timer0 Timer Driver
&P g_timer0 Timer Driver on r_gtm river on r_ioport Sz
Objects
< > || Summary | BSP | Clocks | Pins | Interrupts | Event Links] Stacks | Components
[C] Properties X |[*! Problems @ AV—-k-759%- 2 EY & 8 =M [%3 Pin Conflicts [E) Console | 35 Debug X
g_timer0 Timer Driver on r_gtm
Settings Property Value

Common
~ Module g_timer0 Timer Driver on r_gtm

General
v Interrupts
Callback timer_isr
Underflow Interrupt Priority 5
Generate at Start Disable

Extra Features

Figure 79 : Configuring Interrupts in the Stacks tab

5.2.6 Creating Interrupts from the Interrupts Tab

On the Interrupts tab, the user can bypass a peripheral interrupt set by the FSP by setting a user-defined
ISR. This can be done by adding a new event via New User Event button.

Interrupts Configuration

Generate Project Content

User Events < | New User Event > |«
Event ISR

i ID:78 GTMO INT (GTMO Interrupt) gtm_int_isr

Allocations
Interrupt Event ISR
0 ID:78 GTMO INT (GTMO Interrupt) gtm_int_isr

Summary | BSP | Clocks PinsI Interrup(sl:.--r nks | Stacks | Components

Figure 80 : Configuring interrupt in Interrupt Tab

5.2.7 Viewing Event Links
RZ/A FSP doesn’t support Event Links tab, and it is grayed out.
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5.2.8 Adding Threads and Drivers

Every RTOS-based RZ/A FSP Project includes at least one RTOS Thread and a stack of FSP module
running in that thread. The Stacks tab is a graphical user interface which helps you to add the right modules
to a thread and configure the properties of both the threads and the modules associated with each thread.
Once you have configured the thread, e2 studio automatically generates the code reflecting your
configuration choices.

For any driver, or, more generally, any module that you add to a thread, e2 studio automatically resolves all
dependencies with other modules and creates the appropriate stack. This stack is displayed in the Stacks
pane, which e2 studio populates with the selected modules and module options for the selected thread.

The default view of the Stacks tab includes a Common Thread called HAL/Common. This thread includes
the driver for 1/0 control (IOPORT). The default stack is shown in the HAL/Common Stacks pane. The
default modules added to the HAL/Common driver are special in that the FSP only requires a single instance
of each, which e2 studio then includes in every user-defined thread by default.

In applications that do not use an RTOS or run outside of the RTOS, the HAL/Common thread becomes the
default location where you can add additional drivers to your application.

For a detailed description on how to add and configure modules and stacks, see the following sections:

e Adding and Configuring HAL Drivers
¢ Adding Drivers to a Thread and Configuring the Drivers

Only you have added a module either to HAL/Common or to a new thread, you can access the driver's
configuration options in the Properties view. If you added thread objects, you were able to access the
objects configuration options in the Properties view in the same way.

5.2.9 Adding and Configuring HAL Drivers

For applications that run outside or without the RTOS, you can add additional HAL drivers to your application
using the HAL/Common thread. To add drivers, follow these steps:

1. Click on the HAL/Common icon in the Stacks pane. The Modules pane changes to HAL/Common
Stacks.

2. Click New Stack to see a drop-down list of HAL level drivers available in the FSP.

3. Select a driver from the menu New Stack > Driver.

Stacks Configuration T P e ] R |E
Threads = | HAL/Common Stacks | | New Stack > bbb S
&% HA/Common Connectivity 3 &  12C Master Driver on r_riic_master |
& g_joport /O Port Driver on r_ioport e ‘g{m‘par\ /O Port B g;l\nero-'ﬁmean\-er Graphics > @ 12SDriveronrssi
@ g_timer0 Timer Driver on r_gtm bl TEem Input > <SPl Driveron rrspi I
Networking > @ UARI Driveron r_scii_uart
RTOS > @ USBHHID (r_usb_hhid)
Timers el T i
Transfer > &
o8
§# Search... 80
R
Objects -
Summary | BSP | Clocks | Pins | Interrupts | £v I Stacks ksmpanems » Legend

Figure 81 : e2 studio Project configurator - Adding drivers

4. Select the driver module in the HAL/Common Modules pane and configure the driver properties in the
Properties view.
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e2 studio adds the following files when you click the Generate Project Content button:

e The selected driver module and its files to the rza/fsp directory
e The main() function and configuration structures and header files for your application as shown in

the table below.

File Contents Overwritten by
Generate Project
Content?
rza_gen/main.c Contains main() calling generated and user code. Yes
When called, the BSP has already initialized the MPU
rza_gen/hal_data.c Configuration structures for HAL Driver only modules Yes
rza_gen/hal_data.h Header file for HAL driver only modules Yes
src/hal_entry.c User entry point for HAL Driver only code. Add your No
code here
src/mmu_page_table.c | Virtual memory page table settings No
src/sections.c Rules for section transfer from ROM to RAM No
src/syscalls.c Low-level processing stub for file 1/0 functions No

The configuration header files for all included modules are created or overwritten in the folder

“rza_cfg/fsp_cfg”.

5.2.10 Adding Drivers to a Thread and Configuring the Drivers

For an application that uses the RTOS, you can add one or more threads, and for each thread at least one
module that runs in the thread. You can select modules from the Driver dropdown menu. To add modules to

a thread, follow these steps:

1. In the Threads pane, click New Thread to add a Thread.
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Stacks Configuration

&| New Thread 3| Remove Mew Thread Stacks
Threads

i)

L | Add stacks to the selected thr
(above), or by pasting here fro

v g HAL/Common
48 g_ioport I/0 Port (r_ioport)
48 g_mmu MMU Driver on r_mmu
& FreeRTOS Port (rm_freertos_por|
MNew Thread

Objects 4| New Object >

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components
S| Properties < |'_ Problems Q Smart Browser| &) Console

New Thread

Settings Property Value
v Common
General
Hooks
Stats
Memery Allocation

Timers Enter Symbol Name of your
- thread here.

Logging Example: my_thread
w Thread

Symbaol new threadd Enter Name of your thread here.
Mame MNew Thread ] Example: My Thread

LTS R T Y A

Opticnal Functions

Figure 82 : Adding a new RTOS Thread on the Stack tab

2. In the properties view, click on the Name and Symbol entries and enter distinctive name and symbol for

the new thread.

Note:
e2 studio updates the name of the thread stacks pane to My Thread Stacks.

3. Inthe My Thread Stacks pane, click on New Stack to see a list of modules and drivers.

¥F *[test] FSP Configuration X = B8 | % FSP Visualization X |{&] Pack

Stacks Configuration =] PP

Generate Project Content

Threads & |NewThread #)Remove ||  New Thread Stacks &) New Stac'- ~
— - Connectivity > @ 12CMaster Driver on r_riic_master
v 'F;AL«CWWD{! (@ 1dd stacks to the selected thread by using the New Sta Ceres >| @ 125 Driveron rssi

42 g_ioport I/0 Port Driver on r_ioport W pasting here from the clipboard. b

@ FreeRTOS Port (rm_freertos_port) Input > @ SPIDriver on r_rspi
& New Thread Networking > @  UART Driver on r_scif_uart

RTOS > @ USBHHID (r_usb_hhid)
5

Timers
Transfer
4 Search..

Objects & New Object >

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components » Legend

Figure 83 : Adding Modules and Drivers to a thread
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Select a module or driver from the list.

Click on the added driver and configure the driver as required by the application by updating the

configuration parameters in Properties view. To see the selected module or driver and be able to edit its
properties, make sure the Thread containing the driver is highlighted in the Threads pane.

$¥ [test] FSP Configuration X

Stacks Configuration

Threads ¢ NewThread %)Remove (- g extemal irq External IRQ Driveron rintc_rq ) New Stack >
Stacks

v a¢ HAL/Common
4 g_ioport /O Port Driver on r_icport
4 FreeRTOS Port (rm _freertos_port) @ g_extemal_irg0
v @ New Thread External IRQ Driver on

4 g_external_irq0 External IRQ Driver on r,

< >

Objects

&) New Object >

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks| Components.

] Problems @ AX-1+759Y- | [[] Properties X e
g_external_irq0 External IRQ Driver on r_intc_irq

Settings Value
Default (BSP)
r_inte_irq
g_extemal_irg0
o
Rising
NULL
24

<unavailable>

§ = O [fgPinConflicts E) Console | 45 Debt

Figure 84 : Configuring Module or Driver properties

6. When you press the Generate Project Content button for the example above, e2 studio creates the files

as shown in the following table:

File Contents Overwritten by Generate
Project Content?

rza_gen/main.c Contains main() calling generated and user code. Yes

When called, the BSP will have initialized the MPU.
rza_gen/my_thread.c Generated thread “my_thread” and configuration Yes

structures for modules added to this thread.
rza_gen/my_thread.h Header file for thread “my_thread” Yes
rza_gen/hal_data.c Configuration structures for HAL Driver only Yes

modules.
rza_gen/hal_data.h Header file for HAL driver only modules. Yes
src/hal_entry.c User entry point for HAL Driver only code. Add your | No

code here.
src/my_thread_entry.c | User entry point for thread “my_thread”. Add your No

code here.

5.2.11 Configuring Threads

If the application uses an RTOS, the Stacks tab can be used to simplify the creation of RTOS threads,
semaphores, mutexes, and event flags. The components of each thread can be configured from the

Properties view as shown below:
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[*] Problems @ AV 751 -

Property

~ Common

General

Hooks

Stats

Memory Allocation
Timers

Optional Functions
Legging

~ Thread

Symbol

Name

Stack size (bytes)
Priority

Thread Context
Memory Allocation

B Properties

oE Y B

o0

Value

new_threado
MNew Thread
4096

1

MNULL

Static

Figure 85 : New Thread Properties

The Properties view contains settings which are common for all Threads (Common) and settings for this

particular thread (Thread).

For this thread instance, the thread's name and properties (such as priority level or stack size) can be easily
configured. e2 studio checks that the entries in the property field are valid. For example, it will verify that the

field Priority, which requires an integer value, only contains numeric values between 0 and 9.
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To add RTOS resources to a Thread, select a thread and click on New Object in the Thread Objects pane.
The pane takes on the name of the selected thread, in this case My Thread Objects.

Stacks Configuration =
Threads % | NewThread % | Remove -]  New Thread Stacks &) New Stack > = £«
v s HAL/Common -
47 g_ioport I/O Port Driver on r_ioport @ g—e“errré—' "S"
4 FreeRTOS Port (rm_freertos_port) r’;::;niarq Q Driverion
v % New Thread s
4 g_external_irq0 External IRQ Driver on r_intc_irg
Objects & | New Object >| % | Remove
@ g_new_message_buffer0 Message Buffer
Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components
[*] Problems @ AY-h 759~ | [[] Properties X s Y & § = 0
g_new_message_buffer0 Message Buffer
Settings Property Value
| Symbol g_new_message buffer0 |
Message Buffer Size (Bytes) 512
Memory Allocation Static

Figure 86 : Configuring Thread Object Properties

Make sure to give each thread object a unique symbol by updating the Symbol entries in
the Properties view.
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5.3 Reviewing and Adding Components

The Components tab enables the individual modules required by the application to be included or excluded.
Modules common to all RZ/A MPU projects are preselected. All modules that are necessary for the modules
selected in the Stacks tab are included automatically. You can include or exclude additional modules by
ticking the box next to the required component.

L* *[test] FSP Configuration X = =

Components Configuration arieri o
senerate Project Content
= [ <k Group by: | Vendor v | Filter: |All v | [Search...
Component Version Description Variant A
v o Renesas
v %y BSP
v @ Board
custom Custom Board Support Files
[¥] rza3ul_smarc_qgspi_xip RZ/A3UL Evaluation Board Kit QSPI Edition (eXecute-In-...
v @ rzadul
[¥] device Board support package for ROA07G063U02GBG (RZ/A3UL) R9A07G063U02G...
[¥] device Board support package for RZA3UL (RZA)
[[] device Board support package for ROA07G063U01GBG (RZ/A3UL) R9A07G063U01G...
¥ fsp Board support package for RZ/A3UL (RZ/A3UL) - FSP Data
v ¢y Common
v @ all
[¥] config Application configuration settings (Virtual memory setti...
V| fsp_common Board Support Package Common Files
v @% HAL Drivers
v 7 all
[ reru Camera Data Receiving Unit
r_dmac Direct Memory Access Controller
r_gether Gigabit Ethernet Driver
r_gether_phy Gigabit Ethernet PHY Driver
[¥] r_gtm General Timer
V| r_intc_irq External IRQ Driver(IRQ) v
Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks IComponents |

Figure 87 : Components Tab

By clicking the Generate Project Content button, the .c and .h files for each selected component are copied
into the following folders:

e rza/fsp/inc/api

¢ rzal/fsp/inc/instances

e rzalfsp/src/bsp

e rzalfsp/src/<Driver_Name>

e2 studio also creates configuration files in the rza_cfg/fsp_cfg folder with configuration options set in the
Stacks tab.

5.4 Debugging the Project

Once your project builds without errors, you can use the Debugger to download your application to the board
and execute it.

To debug an application, follow these steps:

1. On the drop-down list next to the debug icon, select Debug Configurations.

AL RE=N

T 1F58 project Debug
Debug As »
Deliug Canfigurations..
Qrganize Favorites.,

Figure 88 : Select of Debug Configurations
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In the Debug Configurations view, click on your project listed as MyProject Debug_Flat.

< Debug Configurations

Create, manage, and run configurations . ﬁ\

FReREX BT -
[type ilter text |
[E] €/C++ Application

[2] ©/C=+ Remote Application
EASE Script [myProject

Name: [ MyProject Debug_Flat] |

[EBR +5 oebugoer| - Stertup| & Source | [ Common

Project:

Browse.

[£] GDB Hardware Debugging C/C++ Application:

[£] GDB GpenCCD Debugging [ ebug/MyProject.eit

[ GDB Simulator Debugging (RHES0) 9Ty Troject

5 Java Applet Variables.. | | SearchProject.. | Browse..

= f"a Aﬁ”ﬁ"““"” Build (i required) before launching

3 Launch Group

T Remote Java Application Build Configuration; | Use Active v

[ Renesas GDB Hardware Debuggin
E@ MyProject Debug Flat oo OEnable auto build O Disable auto build
[E7] Renesas Simulator Debugging (RX, RL78) (® Use workspace settings Configure Workspace Settings...
Revert Apply

Filter matched 13 of 15 items = PPY

Figure 89 : Debug Configuration Window

3. Please set load images and set Reset after download setting to Yes as shown below:

Bl Main | 35 Debugge, Source| [] Cemmon

Initialization Commands

B Maml?,‘;oehuggerlb Startup| % Source | [[] Commen
[JReset and Delay (seconds): 2
OHalt

Debug hardware: | F-Link ARM | Target Device: | ROAD7G063U02GBG

GDB Settings Debug Tool Settings

Register inifialization No
Reset ot the beginning of connection No
I Reset ot the end of connection No

Besetbefore download No
Filename Load type Offset (hex)  On connect Reset after download m
Program Binary [My_Pr.. Image only Yes Lm'm_o e (Bytes)
3ul_smarc_qspi ipl.s.. Image and Symbols  © Ves Hold reset during connect No
My_Projectsrec [CHW..  Imageand Symbols O Yes Set CPSR(Sbit) after downlead No

Figure 90 : Debug Setting

4. Connect the board to your PC via a standalone Segger J-Link debugger and click Debug.
Note:

For details on using J-Link and connecting the board to the PC, see 3.2.2.JTAG connection.
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5.5 Modifying Toolchain Settings

There are instances where it may be necessary to make changes to the toolchain being used (for example,
to change optimization level of the compiler or add a library to the linker). Such modifications can be made
within e2 studio through the menu Project > Properties > Settings when the project is selected. The
following screenshot shows the settings dialog for the GNU Arm toolchain. This dialog will look slightly
different depending upon the toolchain being used.

€ Properties for MyProject o X
| type filter text | | Settings Y > 3§
Resource
A
Builders
~ C/C++ Build Configuration: |Debug [Active] ~ | | Manage Configurations...
Build Variables
Environment
Logging B} Tool Settings i) Toolchain 3 Device # Build Steps Build Artifact a1} Binary Parsers @ Error Parsers
Settings
Tool Chain Editor (22 Target Processor Arm family (-mcpu) | cortex-ass ~
UC++ G | (2} Optimization _
MC[] S : Warings Architecture (-march] | Toolchain default v
Project Natures (£ Debugging Instruction set Toolchain default v
v s ARM GNU Assembler
Project References ] Thumb interwork (-mthumb-interworkd
Renesas QF TEprOCCSSOr
Run/Debug Settings cludes Endianness Toolchain default v
N
Task Tags Sminge Float ABI Toolchain default 7
Validation iscellaneous
v 5 ARM C Compiler FPU Type Toolchain default v
reprocessor =
Unaligned access Toolchain default b
ncludes
ptimization [ TrustZone (-mcmse)
Wamnings e
Aiscellaneous
&) Cross ARM C Linker
eneral
ibraries
(5 Miscellaneous
(5 Other
v B Cross ARM GNU Create Flash Image
(2 General
B Cross ARM GNU Print Size
(2 General 5
@ Apply and Close Cancel

Figure 91 : e2 studio Project toolchain settings

The scope for the settings is project scope which means that the settings are valid only for the project being
modified.

The settings for the linker which control the location of the various memory sections are contained in a script
file specific for the device being used. This script file is included in the project when it is created and is found
in the created project. (for example, script/rza3ul_smarc_qgspi_xip.ld).

5.6 Importing an Existing Project into e2 studio

1. Launch e2 studio.

2. Open an existing Workspace to import the project and skip to step d. If the workspace does not exist,
proceed with the following steps:

a. Atthe end of e2 studio startup, you will see the Workspace Launcher Dialog box as shown in the
following figure.

Eclipse Launcher X

Select a directory as workspace

& studic uses the workspace directory to store its preferences and development artifacts.

WULT S EIRE C Users\ < user_name\e2studio\workspace] ~ Browse...

[]Use this as the default and do not ask again
} Recent Workspaces

Figure 92 : Workspace Launcher dialog
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b. Enter a new workspace name in the Workspace Launcher Dialog as shown in the following figure.
e2 studio creates a new workspace with this name.

Eclipse Launcher X

Select a directory as workspace

& studio uses the workspace directory to store its preferences and development artifacts.

WVEILERElN C:\ Users) < username >\ e2studio\new_workspace] Browse..,

[[] Use this as the default and do not ask again

} Recent Workspaces

Figure 93 : Workspace Launcher dialog - Select Workspace

c. Click [Launch].

d. When the workspace is opened, you may see the Welcome Window. Click on the Workbench
arrow button to proceed past the Welcome Screen as seen in the following figure.

RENESAS Welcome to e2? studio ]
Workbench

Figure 94 : Workbench arrow button

3. You are now in the workspace that you want to import the project into. Click the File menu in the menu
bar, as shown in the following figure:

Q fspWorkspace - FSPproject/confi
File Edit Navigate Search Proje 6 Menu bar

4 Debug < Tool bar

- v|=ﬂ‘
i =+

Figure 95 : Workbench arrow button

4. Click [Import] on the [File] menu or “Import project” on Project Explorer, as shown in the following figure:

File Edit Mavigate Search Project RenesasViews Ru

New AltsShiftsN > | Iy Project Explorer 2 = 0

Open File... =) g\ 7 8
[, Open Projects from File System...

Recent Files 5 There are no projects in your workspace.

To add a project:

ose Edito

ar

Convert Line Delimiters To >

7y Expert..
Properties AltsEnter
Switch Workspace >
Restart.

Exit

Figure 96 : File drop-down menu
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5. In the Import dialog box, as shown in the following figure, choose the General option, then Existing

Projects into Workspace, to import the project into the current workspace.

e |mport a X
Select \
Create new projects from an archive file or directory. E e 5

Select an import wizard:
| type filter text
v = General

B Archive File
(2 _CMSISPack

|'_." Existing Projects into Workspace I
L, File System

T GNUARM-NONE/RZ(DS-5) project conversion to GCC ARM Embedded
[T] Preferences
() Projects from Folder or Archive
& Rename 8 Import Existing C/C++ Project into Workspace
T Renesas CS+ Project for CA78KOR/CA78KO
T Renesas CS+ Project for CC-RX and CC-RL
T Renesas GitHub FreeRTOS (with loT libraries) Project
) Sample Projects on Renesas Website
B> C/C++
(= Code Generator
& Install
& Oomph
& Run/Debug
& Team
& Tracing
= XML

Figure 97 : Project Import dialog with "Existing Projects into Workspace" option selected

6. click [Next >]

7. To import the project, use either Select archive file or Select root directory.
First, choose Select root directory as shown below:

& import [m] ®
Import Projects =
Select a directory to search for existing Eclipse projects. A
(®) Select root directory: [\ V][ Browse..
O Select archive file: B
Projects:
Select All
Deselect Al
Refresh
Options
[ Search for nested projects
[ Copy projects into workspace
[JClose newly imported projects upon completion
[ Hide projects that already exist in the workspace
Working sets
[JAdd project to working sets New..
@ <Back Finish Cancel

Figure 98 : Import Existing Project dialog 1 - Select root directory
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8. Click [Browse...].

9. Choose the directory of the project you would like to import to specify the directory as root directory.
10.Select the project for import.

11.Click [Open].
12.Select the project to import from the list of [Projects:] as shown below:

< Import O X
Import Projects ==

Select a directory to search for existing Eclipse projects. / ‘/
(® Select root directory: | :aary 124 AN onpYala ie a0 we v] | Browse... |
O Select archive file: Browse.
Projects:

Blinky "2¥es - hARLED UL b idelad o ikl ek Bl 5] Select All
Deselect All
Refresh

Figure 99 : Import Existing Project dialog 2 — Select the project to be imported

13.Click [Finish] to import the project.
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6. Notes on development

6.1 Unexpected Update of Program placed on Flash ROM

If the program written to Flash ROM isn’'t updated expectedly even though there is no failure in downloading
your program via e2studio, please check the settings of Flash Bus Type and Flash Memory Type shown in
the figure below:

Q Edit Configuration X

Edit Renesas GDB Hardware Debugging configuration test_bustype Debug_Flat for

Launch Configuration Name: |rza_blinky Debug_Flat

El Main % Debugger | # Startup| & Source| @ Common

Debug hardware: J-Link ARM | Target Device: R9A07GO63U| ...

GDB Settings Connection Settings Debug Tool Settings

v Io ~
Use Default 10 Filename Yes v
10 Filename ${support_area_loc}

+ General Debug
Reset After Reload Yes v

v Memory
Endian Little Endian v

+ Break
Use Flash Breakpoints Yes v
Allow Simulation No v

v Flash
Flash Bus Type OctaBus v
Flash Memory Type OctaFlash v
WorkRam Start
WorkRam End
Erase on-chip program flash before download No v
Erase on-chip data flash before download No v
Use CFl-Flash No v
CFl Start 0x0 ™

@ Duplicate Delete Cancel

Figure 100 : Flash related settings in Debug Tool Settings

When Flash Bus Type and/or Flash Memory Type don’t match the configuration of board shown in the
following table, your program won’t be downloaded properly.

Board Edition Expected Flash Settings
QSPI Edition (RTK9763U02S01000BE) e Flash Bus Type : SPIBSC

e Flash Memory Type : SerialFlash
Octal-SPI Edition (RTK9763U02S01001BE) e Flash Bus Type : OctaBus

e Flash Memory Type : OctaFlash
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6.2 Getting USB Hub to be workable with USBX
When using USB Hub with USBX, please follow the pro shown below:

1. Copy rza/microsoft/azure-rtos/usbx/common/core/inc/ux_user_sample.h to the directory
rzalfsp/src/rm_usbx_port and rename it to ux_user.h.
2. Add the definitions listed below to ux_user.h.

#define UX MAX CLASS DRIVER 3

#define UX MAX ED 80
#define UX MAX TD 128
#define UX MAX ISO_TD 128

3. Add the following definition to rza_azurertos_sample/rza/fsp/src/rm_usbx_port/ux_port.h.

#define UX_ INCLUDE USER DEFINE FILE
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi. (Max.) and Vix (Min.).
7. Pronhibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-
evaluation test for the given product.



Notice

1.

12.

13.
14.

(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’'s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.

. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2024 Renesas Electronics Corporation. All rights reserved.
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